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Introduction

Harmony has several commands, dialog boxes, and buttons. The Reference section lists all of them along w ith 

the matching definition. To understand how to use these functions in a production context, read the User 

guide. 

In the Reference guide, you w ill learn about the various parameters available in dialog boxes, menus, nodes, 

toolbars, views, and w indows. 

The Preferences guide provides additional details about each individual preference. 
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Chapter 1: Dialog Boxes

Chapter 1: Dialog Boxes

Dialog boxes contain controls such as options and lists through which you can carry out a particular command 

or task. For example, in the Scene Settings dialog box, you must indicate the resolution and alignment. A 

typical dialog box looks as follows:

Advanced Save Dialog Box 7

Close Gaps Dialog Box 12

Configure Line Art to Colour Art Dialog Box 13

Create Palette Dialog Box 15

Create Palette from Selection Dialog Box 16

Database Selector Dialog Box 18

Export OpenGL Frames Dialog Box 20

Manage Local Cache Dialog Box 32

Movie Options Dialog Box (macOS) 34

Onion Skin and Light Table Transparency Dialog Box 37

Palette Browser Dialog Box 38

Palette Operations Dialog Box 41

Preferences Dialog Box 43

Recolour Drawings Dialog Box 47

Remove Dirt Dialog Box 49

Remove Hair Dialog Box 50

Set Ease on Keyframes Dialog Box 51

Tint Offset/Blend  Dialog Box 53

Toolbar Manager Dialog Box 54
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Advanced Save Dialog Box

In Harmony Server, the Advanced Save dialog box lets you save the scene as a new version, overwrite an 

existing version, set a new current version, display a list of modified drawings, colour palettes, and modified 

colour palette lists. 

How to access the Advanced Save dialog Box

 1. From the top menu, select File > Save.... 

The Advanced Save dialog appears.
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File Tab

Parameter Description

Save

‣ Enable this option if you want to save the modifications made to the 

current scene. 

‣ Deselect the Save option if you only want to save specific components of 

your scene listed in the Drawings, Palettes or Palette Lists tabs. This w ill 

disable all option in the File tab. 

This Version (number)
Saves the current version of the scene. You can rename the current version by 

typing a new name into the field. 

New Version (number)
Saves the current scene as a new version. You can name this new version by 

typing a name into the field. 

Overwrite Existing Version Lets you select an existing version of your scene from the list to overwrite it.

Description
Use this field to add or edit an existing description for the scene version you want 

to save. 

Mark as Current

Lets you set this scene version as the current one. This version w ill be 

automatically selected as the default current version when the scene is selected 

in the Database Selector dialog box

8



Drawings (Harmony Server only) 

The Drawings tab lists the modified drawings.

Parameter Description

Drawing list
Lets you select the modified drawings to save, and deselect the ones you do not 

want to save.

Select All Selects all modified drawings in list.

Deselect All Deselects all modified drawings in the list.

Palettes Tab

The Palette tab lists the modified colour palettes.
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Parameter Description

Colour Palette list
Lets you select the colour palette to save, and deselect the ones you do not want 

to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified colour palettes in the palette list.

Deselect All Deselects all modified colour palettes in the palette list.

Palette Lists Tab

The Palette Lists tab lists all the modified colour palette lists.
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Parameter Description

Palette Lists
Lets you select the modified palette list to save, and deselect the ones you do not 

want to save.

Show Recovered Displays the recovered palettes in the list of modified palettes.

Select All Selects all modified palette lists in the list.

Deselect All Deselects all modified palette lists in the list.

11

Harmony 22 Paint Reference Guide                          



Chapter 1: Dialog Boxes

Close Gaps Dialog Box

The Close Gaps dialog box lets you close up drawing areas that not are closed. This may sometimes happen 

when painting. You can close small gaps in a drawing by creating small, invisible strokes between the two 

closest points to close the colour zone. You do not need to trace directly over the gap. You can draw it a few 

millimeters away. The two closest points automatically close the gap.

How to access the Close Gaps dialog box

 1. Select View >Show Strokes or press K to see a preview of the result.

 2. To flatten the strokes you draw, click the Auto-Flatten  button in the Tool Properties view.

 3. Select Drawing > Close Gaps or press Shift + F10 (W indows/Linux only).

The Close Gaps dialog box opens.

Parameter Description

Size Lets you set the size of the gap you want to be closed.

Apply to all drawings Closes all gaps in the drawing of the selected layer.
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Configure Line Art to Colour Art Dialog Box

The Configure Line Art to Colour Art dialog box lets you modify settings for the Line Art and Colour Art layers.

How to access the Configure Line Art to Colour Art dialog box

 1. In the Tools toolbar, select the Select tool. 

 2. In the Tool Properties view, hold down the Shift key and click on the Creatre Colour Art from Line 

Art button.

Parameter Description

Use rendered version of the 

drawing

Renders the drawing and vectorize it to calculate the position of the centreline 

that w ill produce the colour art stroke.

Maximum Resolution for 

rendered image
The size of the rendered image.

Threshold for rendered 

image
The value of grey processed to create the rendered vectorized arts.

Fitting error for rendered 

Beziers

This value represents how precise the fitting of the colour art zone in relation to 

the line art w ill be.

Source layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 

colour art to be created from.

Destination layer
Lets you select the layer (Line Art, Colour Art, Underlay or Overlay) you want the 

colour art to be created on.

Clear Destination Art Layer Deletes the content before the colour art is added. This is useful when you 
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First already have artwork on the destination layer.

Perform Line Art to Colour 

Art Operation Immediately
Performs the Create Colour Art from Line Art command when you click OK.
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Create Palette Dialog Box

The Create Palette dialog box allows you to create a colour palette for your scene. Palettes created w ith this 

dialog box are added to your scene's palette list, and stored in your scene's palette-library subdirectory.

NOTE 

If you have the Advanced Palette Lists preference enabled, the dialog w ill also have a palette 

browser, which allows you to decide where the palette is stored and whether to add it to the scene 

or the element's palette list—see Palette Browser Dialog Box on page 38.

How to access the Create Palette dialog box

 1. Do one of the follow ing:

 l In the Colour View, click the New Palette  button over the palette list.

 l From the Colour view menu, select Palettes  > New

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose the palette type to create:

 l Colour: A colour palette can contain colours, gradients and bitmap textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 

transparency filters to pencil l ines, in combination to their l ine colour, to create 

various styles of pencil l ines.
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Create Palette from Selection Dialog Box

The Create Palette from Selection dialog box allows you to create a palette that contains all the colours used 

by all the drawings in the selected drawing layers. 

This can be useful, for example, if the colour design for a character model or rig, a background or another kind 

of asset was made using several different palettes, and you need to consolidate all of the colours used by the 

asset into its own dedicated palette. 

NOTES 

 l The Create Palette from Selection dialog uses the colours in all the drawings in the selected 

layers, even drawings that are not exposed. 

 l For tasks related to this dialog box, see the User Guide.

How to access the Create Palette from Selection dialog box

 1. In the Timeline, Xsheet, Camera or Node view, select one or more drawing layers. 

 2. In the top-left corner of the  Colour view, open the  View Menu and select Palettes > New 

Palette from Selected Drawings. 

Parameter Description

New Palette Name Allows you to type in the name of the palette to create.

Palette Type

Allows you choose one of the type of palette to create:

 l Colour: Creates a palette containing all the colours, gradients and bitmap 

textures used in the selected drawing layers.

 l Pencil Texture: Creates a palette containing all the pencil textures used in the 

selected drawing layers.

Generate New Colour 

IDs and Recolour 

Selected Drawings

By default, the Create Palette from Selection dialog box generates the palette by 

copying the colour swatches used in the selected drawings from their original palette 

into a new palette, along w ith their colour ID. This means that the colour swatches in the 

generated palette w ill use the same colour IDs as the ones in the original palettes.
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If you select this option, Harmony w ill generate a palette w ith new colour IDs, and w ill 

replace the old colour IDs in your artwork w ith the new ones. This w ill usually have no 

visible effect, and w ill prevent the swatches in the new palette from having the same 

colour IDs as the swatches you originally used to colour your artwor. W hen two palettes 

have a swatch w ith the same colour ID, Harmony uses the swatch from the top-most 

palette in the palette list. 

NOTE 

If your artwork uses Colour-Override effects, the colour IDs used by these Colour-

Override w ill not be replaced w ith the new colour IDs, making the Colour-Override 

ineffective unless you reconfigure them manually. Hence, you should avoid using 

this parameter if you are consolidating the palette of a character rig that uses a lot 

of Colour-Overrides. 
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Database Selector Dialog Box

The Database Selector dialog box lets you connect to your studio's central database when working on 

Harmony Server. 

NOTE 

W hen you connect to the database, you cannot create new scenes directly from Harmony. The 

available scenes must have been already created using the Control Center module. 

How to access the Database Selector dialog box

 1. Start Paint

 2. In the User Name field, type in your Harmony Server username.

 3. Click on OK.

The Database Selector dialog box opens.

Parameter Description

Environments Lets you select the scene's environment (project, movie).

Jobs Lets you select the scene's job (episode, sequence). 
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Scenes Lets you select the scene.

Get rights to modify the 

scene

Allows you to modify the selected version of the scene as well as to manage and 

overwrite other versions. Other users w ill not be able to open a different version 

of the scene until you close the scene.

Get rights to modify the 

scene version

Allows you to modify the currently selected scene version only. Unless the Get 

rights to modify the scene option is also checked, you w ill not be able to change 

other versions of the scene. This allows other users to modify different versions of 

the scene while you are working on the selected version.

Get rights to modify all scene 

assets

Automatically gets the rights to modify all of the scene's assets, locking other 

users from making changes to them until you close the scene. This means that 

you w ill have the rights to modify all the scene's versions, drawings, palettes, its 

palette list, but not its library folder. If this option is unchecked, drawings and 

palettes w ill be locked unless you unlock them manually. This can allow another 

user to work on the scene's drawings and palettes in Paint while you are working 

on the scene's timing or staging in Harmony.

Cache scene assets locally

Downloads the scene's drawings to your computer before opening the scene. 

Harmony w ill then load the drawings from your computer during the session, 

instead of loading them from their original location over the network. This can 

significantly increase performance, especially w ith resource-heavy scenes. 

W hen you save your scene, the updated drawings w ill be uploaded automatically 

to the database, so you do not have to re-upload them manually. 

NOTE 

If this option is checked, it may take a while to download all of the scene's 

assets when opening a particularly heavy scene.

Version If you saved different versions of a scene, this lets you select one to open.
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Export OpenGL Frames Dialog Box

The Export OpenGL Frames dialog box allows you to export your scene as a sequence of images as they 

appear in the OpenGL View mode of the Camera view. This means they are exported w ithout effects, 

antialiasing and proper compositing. This allows you to quickly preview the animation in your scene w ithout 

having to wait through the full rendering process.

How to access the Export to OpenGL Frames dialog box

 1. In the top menu, select File > Export > OpenGL Frames.

Parameter Description

Output

Location

The directory in which to export the frames or movie file. 

You can click Browse... to open a dialog allowing you to navigate your file system 

and select a directory.

Filename

The name of the file to export. 

If you are exporting frames, the file name of each frame will start w ith this value, 

followed by the number of the frame. 

Format

Image Sequence Select this option to create an image sequence.

Movie Exports the frames into a movie file. 

Frames Exports each frame as an individual image file. 

Suffix Allows you to select the number of digits in the number used to identify each frame.
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Parameter Description

Drawing Type

Format Specification Description

TGA                                              Full colour

Truevision TGA/TARGA (*.tga)

A standard image format w ith lossless 

compression and support for 

transparency. 

TGA files use more disk space than 

PNG files, but rendering in TGA is 

faster. 

TGA1                                              Greyscale

TGA3                                              Full colour

TGA4                                              
Full colour w ith 

transparency

SGI                                              
Full colour / 8 bits 

per channel

Silicon Graphics Image (*.sgi)

A highly capable format w ith lossless 

compression as well as support for 

double precision and transparency.

SGI1                                              
Greyscale / 8 bits 

per channel

SGI3                                              
Full colour / 8 bits 

per channel

SGI4                                              

Full colour w ith 

transparency / 8 

bits per channel

SGIDP                                              
Full colour / 16 bits 

per channel

SGIDP3                                              
Full colour / 16 bits 

per channel

SGIDP4                                              

Full colour w ith 

transparency / 16 

bits per channel

PSD                                              
Full colour / 8 bits 

per channel

Photoshop Document (*.psd)

An Adobe Photoshop proprietary 

format used for image editing. 

PSD files exported by Harmony 

contain a single background layer w ith 
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Parameter Description

Format Specification Description

the rasterized image. 

NOTE 

PSD files exported from 

Harmony are tagged w ith 

their colour space 

information in their 

metadata, except for PSD 

files exported in greyscale. 

PSD1                                              
Greyscale / 8 bits 

per channel

PSD3                                              
Full colour / 8 bits 

per channel

PSD4                                              

Full colour w ith 

transparency / 8 

bits per channel

PSDDP                                              
Full colour / 16 bits 

per channel

PSDDP1                                              
Greyscale / 16 bits 

per channel

PSDDP3                                              
Full colour / 16 bits 

per channel

PSDDP4                                              

Full colour w ith 

transparency / 16 

bits per channel

YUV                                              

Y'UV frame (*.yuv)

A legacy format optimized for NTSC 

television. The image information is 

encoded in the Y'UV color space, 

which means Luma (Y') and 

Chrominance (UV). 

NOTE 

YUV images must be 

exported in NTSC 

resolution (720 x 540), or 

they w ill not be legible.
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Parameter Description

Format Specification Description

PAL                                              

PAL frame (*.pal)

A legacy format optimized for PAL 

television.

NOTE 

PAL images must be 

exported in PAL resolution 

(768 x 576), or they w ill 

not be legible. 

SCAN                                              

Toon Boom Scan Files (*.scan)

A Toon Boom proprietary format used 

by Scan to store scanned image 

information along w ith its registration 

(peg), resolution and field chart 

metadata. SCAN files are in gresycale. 

PNG                                              
Full colour / 8 bits 

per channel

Portable Network Graphics (*.png)

A highly portable image format w ith 

high lossless compression as well as 

support for transparency and double-

precision. PNG is typically used for 

W eb applications, graphical user 

interfaces and image sharing. 

Rendering in PNG takes more time 

than rendering in TGA or in 

uncompressed image formats, but 

saves a lot of disk space. 

NOTE 

PNG files exported from 

Harmony are tagged w ith 

their colour space 

information in their 

metadata.

PNG4                                              

Full colour w ith 

transparency / 8 

bits per channel

PNGDP                                              
Full colour / 16 bits 

per channel

PNGDP3                                              
Full colour / 16 bits 

per channel

PNGDP4                                              

Full colour w ith 

transparency / 16 

bits per channel

JPG                                              Jpeg (*.jpg)
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Parameter Description

Format Specification Description

A very compact image format w ith 

lossy compression. It is typically used 

for W eb pages and photo sharing. 

Because it does not preserve image 

quality, it is recommended to never 

render in Jpeg format unless you are 

exporting stil ls for a W eb page or are 

making quick render tests. 

BMP                                              Full colour Bitmap (*.bmp)

A standard uncompressed image 

format commonly used on Microsoft 

operating systems. BMP4                                              
Full colour w ith 

transparency

OPT                                              Full colour

Toon Boom Optimized image (*.opt)

A legacy Toon Boom proprietary 

format that stores bitmap image data 

w ith lossless compression. It supports 

transparency.

OPT1                                              Greyscale

OPT3                                              Full colour

OPT4                                              
Full colour w ith 

transparency

VAR                                              

Toon Boom Variable Header image 
(*.var)

A legacy Toon Boom proprietary 

format that stores greyscale bitmap 

image data w ith lossless compression.

TIF                                              

Tagged Image File Format (*.tiff)

An image format w ith many 

compression and encoding settings. It 

is often used for image exchange in 

visual arts and publishing.

TIFF images exported by Harmony are 

uncompressed, encoded on a per-pixel 

(interleaved) basis in PC byte order. 
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Parameter Description

Format Specification Description

DPX                                              

8 bits per channel / 

Full color / RGB 

channel order

Digital Picture Exchange (*.dpx)

A professional photo format that 

supports various different approaches 

to storing colour information, which 

can be used for storing, exchanging 

and editing raw information recorded 

by cameras. It is commonly used in film 

production. 

DPX3_8                                             

8 bits per channel / 

Full color / RGB 

channel order

DPX3_10                                             

10 bits per channel 

/ Full color / RGB 

channel order

DPX3_12                                            

12 bits per channel 

/ Full color / RGB 

channel order

DPX3_16                                           

16 bits per channel 

/ Full color / RGB 

channel order

DPX3_10_

INVERTED_

CHANNELS                                             

10 bits per channel 

/ Full color / BGR 

channel order

DPX3_12_

INVERTED_

CHANNELS                                             

12 bits per channel 

/ Full color / BGR 

channel order

DPX3_16_

INVERTED_

CHANNELS                                             

16 bits per channel 

/ Full color / BGR 

channel order

EXR                                              
16 lines Zip 

compression

OpenEXR (*.exr)

A highly capable deep image format. 

Each pixel in an EXR file is exported 

w ith its Z-depth information. 

Additionally, if a pixel is semi-

transparent, the color and depth 

information of pixels further back is 

stored along w ith it. If your scene has 
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Parameter Description

Format Specification Description

multiplane or 3D elements, this format 

can be used for compositing your 

animation w ith other graphical 

elements in 3D animation software.

NOTES 

 l OpenEXR files 

exported from 

Harmony are tagged 

w ith the white point 

and primaries 

coordinates for their 

colour space.

 l OpenEXR files are 

always exported by 

Harmony always have 

1 line Zip compression 

if they contain a 3D 

image.

EXR_ZIP_1LINE
1 line Zip 

compression

PDF                                              

Portable Document File (*.pdf)

Typically, PDF files are used to store, 

archive, share and print documents. 

However, Harmony uses the PDF 

format for its capability to store bitmap 

images and vector graphics.

If the write node is connected to a 

vector drawing layer or to a vector 

composite, the exported PDF files w ill 

contain the image as a vector graphic. 

It w ill ignore bitmap layers, effects and 

deformations. Otherwise, the PDF files 

w ill contain the rendered image as a 

bitmap.

DTEX                                              

Deep Texture (*.dtex)

A commonly used deep image format. 

Each pixel in an DTEX file is exported 

w ith its Z-depth information. 

Additionally, if a pixel is semi-

transparent, the color and depth 
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Parameter Description

Format Specification Description

information of pixels further back is 

stored along w ith it. If your scene has 

multiplane or 3D elements, this format 

can be used for compositing your 

animation w ith other graphical 

elements in 3D animation software.

NOTE 

Exporting in Deep Texture 

requires RenderMan to be 

installed on the machine 

and the path to 

RenderMan properly 

configured in Harmony. 

For more information, see 

the Setting 3D Renderer 

Paths topic of the User 

Guide.

Image Format

Drop list w ith all formats listed alphabetically. 

 l BMP

 l DPX

 l DTEX

 l EXR

 l JPG

 l OPT

 l PAL

 l PDF

 l PNG

 l PSD

 l SCAN

 l SGI

 l TGA

 l TIF
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Parameter Description

 l TVG

 l VAR

 l YUV

Colours

Drop list w ith colour modes. Available modes depend on the selected file type.

 l Greyscale

 l Colour

 l Colour + Alpha

Depth 

(bits/channel)

Drop list w ith bit depth value and a label next to it "bits/channel". Available bit depth 

depends on the selected file type.

 l 8

 l 10

 l 12

 l 16

       

Compression

Drop list that appears for EXR and TIF formats only.

 l Zip (per scanline)

 l Zip (16 scanlines)

Inverted Channels A checkbox that appears for DPX only in 10, 12, 16 bit depths.

Movie options

Opens the movie settings dialog box for your selected video format, in which you can 

set the video and audio compression settings for your video file:

 l QuickTime Movie (*.mov) on W indows: Movie Options Dialog Box (macOS),

 l QuickTime Movie (*.mov) on macOS: QuickTime Movie Settings Dialog Box 

(W indows)

 l W indows Media Video (*.wmv): W indows Media Video Settings Dialog Box 

(W indows)

NOTE 

This button is available on W indows and macOS only.

28



Parameter Description

Video options 

Opens the video settings dialog box, which allows you to set the video compression 

settings for your video file—see OpenQuickTime Video Options Dialog Box.

NOTE 

This button is available on GNU/Linux only.

Sound options 

Opens the audio settings dialog box, which allows you to set the audio compression 

settings for your video file—see OpenQuickTime Sound Options Dialog Box. 

NOTE 

This button is available on GNU/Linux only.

Movie Format

Allows you to choose one of the follow ing movie formats:

 l QuickTime ProRes Movie (*.mov): The Apple QuickTime format. This is the 

default export format and is recommended for its portability, and also 

because it allows you to choose among several video codecs.

NOTES 

 l On W indows, Apple QuickTime must be installed to allow 

Harmony to export QuickTime movies. You can configure the export 

of QuickTime movies to use any codec that is compatible w ith 

QuickTime, including H.264, MPEG-4 and Animation.

 l On macOS, Harmony uses Apple AVFoundation to export 

QuickTime movies, which allows you to export using codecs such as 

H.264, Apple ProRes 422 and Apple ProRes 4444, among others.

 l If you are looking to export a QuickTime movie w ith transparency, 

be sure to choose a codec that supports encoding w ith an alpha 

channel.

 l On GNU/Linux, Harmony uses the OpenQuickTime library to export 

QuickTime movies. This only allows you to export videos in non-

proprietary formats such as Motion-JPEG, Photo JPEG, PNG or 

Uncompressed (RGB).

 l H.264/MPEG-4                      (*.mov)                    : A simple movie format that uses the H.264 codec, 

which is supported by most web browsers.
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Parameter Description

NOTES 

 l Using this format does not require additional software. However, if 

this is the first time you export a movie in H.264/MPEG-4 format, 

you w ill be prompted to download the OpenH264 library from 

Cisco. Simply click Yes when prompted, and Harmony w ill 

automatically download the library, then export the movie. 

 l There are no encoding options for this format. 

 l This format supports resolutions of up to 4096×2304. Each 

dimension must be a multiple of 16 pixels. 

 l Audio exported in this format is encoded in PCM 16-bit stereo, 

22.05 kHz.

 l W indows Media Video (*.wmv): The native format for W indows Media 

Player.

NOTES 

 l W indows Media Video (.wmv) files can only be exported on 

W indows. 

 l Video players and editors on non-W indows systems can generally 

not open W indows Media Video (.wmv) files.

Options

Open in Player

If checked, the exported images or movie w ill be opened after the export is finished:

 l If you are exporting frames, they w ill be opened in the Play application.

 l If you are exporting a movie, it w ill be opened in your operating system’s 

movie player.

Resolution

Allows you to specify a resolution to export in, relative to your scene's actual 

resolution:

 l Same as Scene Resolution: Exports a movie in the same resolution as your 

scene's resolution.

 l 3/4 of Scene Resolution: Exports a movie at 75% of the scene's w idth and 

height. 

 l 1/2 of Scene Resolution: Exports a movie at 50% of the scene's w idth and 

height.

 l 1/4 of Scene Resolution: Exports a movie at 25% of the scene's w idth and 

height.
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Parameter Description

 l Custom: Allows you specify the preferred resolution of your exported video 

file, in pixels, in the W idth and Height fields.

Range

Allows you to specify the range of frames in your scene to export:

 l All Frames: Exports all the frames in your scene.

 l From / to: Allows you to specify the frame range to export using the two 

input fields to the right. The first input field is for specifying the first frame to 

export, and the second one is for specifying the last frame to export. All the 

frames in-between, including the ones specified, w ill be exported.

 l Current Frame: Exports the current frame only.

 l Selected Frames: Allows you to select which frames to export. You can 

enable or disable exporting a specific frame by clicking on it. You can also 

toggle exporting a range of frames by clicking and dragging over that range in 

the list. 

OK Exports OpenGL frames w ith the selected settings and closes the dialog box.

Cancel Closes the dialog box w ithout exporting anything.
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Manage Local Cache Dialog Box

The Manage Local Cache dialog box displays a list of all the Harmony Server scenes for which you have 

cached drawings. In this dialog, you can check if the drawings you have in a scene's cache match the drawings 

in the database server, you can delete unused caches and you can change the directory in which scene data is 

cached. 

NOTE 

A scene's data is cached on your computer when you check the Cache scene assets locally option 

in the Database Selector before opening the scene—see Database Selector Dialog Box on page 

18. 

How to access the Manage Local Cache dialog box

 1. In the top menu, select File > Manage Local Caches.

The Manage Local Caches dialog appears.

Parameter Description

List of scene 

caches

The list of caches stored on your computer. There is one item for each scene for which there is 

cached data. Each item is identified by the scene's environment, followed by its job, then its 

name, in this format: 

Environment/Job/Scene

If you select a scene cache in the list, the Manage Local Caches dialog w ill compare the 

drawings that are cached on your computer to the drawings in the actual scene in the 

database, and report if they are identical or not in the Local Cache Status field. 
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Parameter Description

Local Cache 

Status

If you select a cache, the Manage Local Cache dialog w ill analyze whether the data in the 

selected cache matches the data in the actual scene in the Harmony Server database. 

If it displays Scene's Local Cache is identical to the database, then the drawings in the 

selected cache on your computer are identical to the drawings in the corresponding scene in 

the database, meaning that your cache and that the database are up to date. 

If it displays Scene's Local Cache is different than database, then some drawings in the 

selected cache on your computer are different from the drawings in the corresponding scene in 

the database. This usually means one of the follow ing:

 l If the selected cache is the cache of the currently opened scene and you just saved your 

scene, Harmony may stil l be uploading the updated drawings to the database. In this 

case, you can close the dialog, wait a few seconds, and reopen it to see if Harmony is 

done uploading the drawings. If it is, it w ill report that the cache is identical to the 

database.

 l If this is not the cache of the currently opened scene, it is likely that the database scene 

has been changed by someone else since the last time you opened it. That would mean 

that the database version is more up to date than your cache. This is not a problem, as 

next time you open the scene, your cache w ill be updated. 

Local Cache 

Root Folder

Indicates where scene caches are stored on your computer. By default, scene caches are stored 

in a folder named Toon Boom Harmony Local Cache, inside your Documents folder.

Browse

Allows you to change the folder where caches are downloaded when you open a scene. 

NOTE 

The caches that are currently stored on your machine w ill not be moved to their new 

location. Hence, when you change the local cache root folder, the list of scene caches w ill 

become empty until you open a scene. 

Remove

Deletes the selected scene cache from your computer.

NOTE 

This button is greyed out if the selected scene cache is for the currently opened scene, as 

this cache is currently in use by Harmony. 

Close Closes the dialog.
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Movie Options Dialog Box (macOS)

The Movie Options dialog box allows you to configure the video and audio settings when exporting a movie in 

QuickTime Movie (.mov) format on macOS. 

NOTES 

 l For tasks related to this dialog box, refer to the User Guide. 

 

How to access the Movie Settings dialog box                 

 1. From the top menu, select File > Export > Movie.

The Export Movie dialog box appears.

 2. In the Movie Format drop-down, select QuickTime ProRes Movie (*.mov).

 3. Click on the Movie Options button.

The QuickTime Movie Options dialog box appears.
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 4. In the Codec drop-down, select any of the movie options.

How to access the Movie Settings dialog box from the Export OpenGL Frames dialog

 1. In the top menu, select File > Export > OpenGL Frames.

The Export OpenGL Frames dialog box appears.

 2. In the Format section, select Movie.

 3. In the Movie Format drop-down, select QuickTime Movie (*.mov).

 4. Click on the Movie Options button.

Parameter Description

Video

Codec

Allows you to select which algorithm to use to compress the video data. The follow ing 

video codecs are supported:

 l H.264 Legacy: A very effective lossy compression algorithm that is commonly 

supported by web browsers and media players. 

 l H.265  Legacy: Same compression quality as H.264, but w ith a smaller compression 

size. This is useful for videos intended for the web and mobile devices. Not 

supported on all major browsers or operating systems. 

 l Apple ProRes 422  Legacy: A nearly lossless compression algorithm commonly 

used for video editing on Apple systems. This codec is optimized for preserving 

video quality, but not for publishing or streaming.

 l Apple ProRes 422 HQ  Legacy: Preserves visual quality at the same high level as 

Apple ProRes 4444 but for 4:2:2 image sources (cleaner footage for things like 

green screening). Heavier than Apple ProRes 422 for real-time editing performance.

 l Apple ProRes 422 LT  Legacy: A more highly compressed codec than Apple ProRes 
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Parameter Description

422, w ith roughly 70 percent of the data rate and 30 percent smaller file sizes. This 

codec is perfect for environments w ith limited storage capacity and data rates.

 l Apple ProRes 422 Proxy  Legacy: An even more highly compressed codec than 

Apple ProRes 422 LT, intended for use in offline workflows that require low data 

rates but full-resolution video.

 l Apple ProRes 4444  Legacy: A nearly lossless compression algorithm commonly 

used for video editing on Apple systems. Compared to Apple ProRes 422, this codec 

preserves more colour detail and supports transparency. However, it results in 

heavier file sizes.

Alpha

Check this option if you want to export a video w ith transparency.

NOTE 

This option is only available when exporting w ith the Apple ProRes 4444 codec. Other 

codecs do not support transparency.

Sound Uncheck this checkbox if you want to export a movie w ithout an audio track.

Rate

Allows you to select the sample rate, or frequency, in which to export the audio track for the 

movie.

NOTE 

Harmony cannot export audio at a higher sample rate than 22.050 kHz. If you select a 

higher sample rate, your project's audio w ill be upsampled, which means it w ill take 

more disc space w ithout increasing in quality. 

Use

Allows you to select whether to export the movie's audio track using the Mono or Stereo 

channel mode.

NOTE 

Stereo sound has a separate track for the left and right speakers, whereas mono sound 

only has a single audio track for all speakers. 
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Onion Skin and Light Table Transparency Dialog Box 

T-ANIMPA-006-009

This dialog box lets you adjust the Onion Skin and Light table transparency parameters.

How to access the Onion Skin and Light Table Transparency dialog box 

 l In the Drawing view toolbar, click on the Top Light button to open the Onion Skin and Light 

Table Transparency dialog box.

Command Description

Onion Skin Opacity

Sets the maximum opacity value for the onion skin opacity display.  Moving the 

slider all the way to the left = 0% opacity. Moving the slider all the way to the 

right = 100% opacity.

Lighttable Opacity

Sets the maximum opacity value for the light table display. Moving the slider all 

the way to the left = 0% opacity. Moving the slider all the way to the right = 

100% opacity.

LightTable W ash

Sets the washed-out value for the light table display.  Moving the slider all the 

way to the left = 0% opacity. Moving the slider all the way to the right = 100% 

opacity.

Bitmap Background 

W ash

Sets the maximum opacity value for the background wash.   Moving the slider all 

the way to the left = 0% opacity. Moving the slider all the way to the right = 

100% opacity. Only works for bitmap layers.

Pencil Lines Opacity

Sets the maximum opacity value for central vector lines (lines made by the 

Pencil or Shape tools). Moving the slider all the way to the left = 0% opacity. 

Moving the slider all the way to the right = 100% opacity.
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Palette Browser Dialog Box

The Palette Browser dialog allows you to decide the level of palette list and palette storage to use when you 

want to create, clone, link to or import a palette. 

This dialog only appears if you have the Advanced Palette Lists preference enabled, which is disabled by 

default. W hen Advanced Palette Lists mode is disabled, Harmony automatically stores palettes in a scene's 

palette list, inside the scene's palette-library subdirectory. 

How to access the Palette Browser dialog box

 1. Start Paint and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

 4. In the Palette Operations dialog box that opens, select the palette you want to clone at the location 

and level in which it was stored. 

 5. Click Clone.

Parameter Description

Palette Location

This allows you to browse for the physical location of the palette file in your 

database.

If you are using Harmony Stand Alone, you can stil l select the scene's own job or 
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environment as a location. Stand alone scenes have a provisional job and 

environment storage space inside the scene's directory. The files in these storage 

spaces can be imported into a database scene's actual job and environment when 

importing the scene to a Harmony database. If you never intend to use Harmony 

Server, you should keep your palettes inside your scene or element's palette 

libraries. 

Environment

Stores the palette file in the selected environment's palette library. Environments 

are typically used to contain a whole production, series or feature film. 

 l In Harmony Server, this stores the palette in /USA_DB/environments/

[environment name]/palette-library.

 l In Harmony Stand Alone, this stores the palette inside the scene's 

directory, under environments/Digital/palette-library.

Job

Stores the palette file in the selected job's palette library. Jobs are typically used 

to contain episodes in a series, or any set of scenes that is intended to be put in 

the same sequence. 

 l In Harmony Server /USA_DB/jobs/[job name]/palette-library. 

 l In Harmony Stand Alone, this stores the palette inside the scene's 

directory, under jobs/Digital/palette-library.

Scene
Stores the palette file in the selected scene's palette library, which is the 

palette-library subdirectory of the scene's directory.

Element

Stores the palette file inside the  selected element's palette library. This library is 

located inside the scene's directory, under elements/[element 

name]/palette-library.

Palette This lists the existing palettes in the selected location. 

New Palette Name

If you are creating or cloning a palette, use this field to enter the palette file's 

name. The palette w ill be listed under this name in your palette list. On your file 

system, it w ill be named after its palette name, followed by the extension .plt. 

Palette Type

W hen creating a palette, you can choose between the follow ing palette types:

 l Colour: A colour palette can contain colours, gradients and bitmap 

textures.

 l Pencil Texture: A pencil texture palette can contain textures to apply as 

transparency filters to pencil l ines, in combination to their l ine colour, to 

create various styles of pencil l ines.
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Palette List
This allows you to decide if you want the palette to be added to your scene's 

palette list, or to the currently selected element's palette list. 

Scene Palette List

Adds the palette to the scene's palette list. Palettes in the scene's palette list are 

available to all the elements in your scene. This is especially useful if you are 

doing digital animation, where character models can be made of many layers that 

need to use the same palette. 

Element Palette List

Adds the palette to the currently selected element's palette list. Palettes in an 

element's palette list can only be used by the drawings in this element, and w ill 

only be listed in the Colour view when this element is selected. This can be useful 

if you are doing traditional animation, where each character is usually drawn on a 

single layer, and you want each layer to have its own palette. 
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Palette Operations Dialog Box

W hen you start Toon Boom Harmony connected to the database, you can access the Palette Operations 

dialog box which lets you clone, rename, or delete palettes in your database, w ithout having to open a scene 

or browse the database's file system in your operating system's shell. 

In Harmony, palettes are individual *.plt files that can be copied, transferred and stored. W hen a palette is 

created from Harmony, it needs to be stored somewhere. By default, the palette file is stored in the scene 

directory in a palette- library folder unless you specify a different location.

There are four locations where you can find palette- library folders: Element, Scene, Job and Environment.

How to access the Palette Operations dialog box

 1. Start Paint and log in. 

 2. Close the Database Selector dialog box. 

 3. From the top menu, select Tools > Palette Operations. 

Parameter Description

Environment The production, project, feature film or series.

Job The episode and sequence from each environment.

Scene The scenes from each job.

Element The layers and columns in each scene.

Palette The scene palettes.

Description Notes, if any, of the project.
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Clone
Opens the Palette Browser dialog box from which you can select the level in 

which to store the palette file.

Rename Lets you rename a palette.

Delete

Lets you delete a palette.

NOTE 

It is not recommended to disable the warning message that appears when 

you are attempting to delete a palette as this operation cannot be undone.

Close Closes the Palette Operations dialog box.

42



Preferences Dialog Box

The Preferences dialog box allows you to adjust preferences to suit your workflow and your production's 

needs.

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

How to open the Preferences dialog box

 1. Do one of the follow ing:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony [Edition] > Preferences.

 l Press ⌘  + U.
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Paramet

er
Description

Preferenc

e Set

This drop-down allows you to select among one of the available preference presets.

The different preference presets have a lot of settings in common. The follow ing table lists how each 

preset differs for specific preferences:

Tab / 
Location

Preference

Preference Set

Basic
Compositin

g

Cutout 
Animatio

n

Paperless 
Animatio

n
Rigging

General

Focus on 
Mouse 
Enter

Off On On On On

Default 
Separate 
Position for 
Pegs

Off Off On Off On

Stop-
Motion 
Keyframes

Off Off On Off On

Timeline

Reduce 
Indentation

Off On On Off On

Drawing 
Substitutio
n: Create 
Key 
Exposure

On Off Off Off On

Advance
d

Support 
Overlay 
and 
Underlay 
Arts

Off On On Off On

Advanced 
Palette List

Off On On On On
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Paramet

er
Description

Tab / 
Location

Preference

Preference Set

Basic
Compositin

g

Cutout 
Animatio

n

Paperless 
Animatio

n
Rigging

Advanced 
Element 
Mode

Off On Off Off Off
Advanced 
Element 
Mode

Off On Off Off Off
Advanced 
Element 
Mode

Off On Off Off Off

Element 
Node 
Animate 
Using 
Animation 
Tools

On On Off On Off

Pencil 
Tool 
Propertie
s

Auto Close 
Gap

On On On On Off

Save... Allows you to export your current preference settings as an XML file, which you can import later.

Load... Allows you to browse for and import a preference file that was exported w ith the Save... button.

Preferenc

e Tabs

W here you can browse for and change preferences. 

NOTE 

For a list of all the preferences as well as their functionality, refer to the Preferences guide.

Restore 

All 

Defaults

Restores all your preferences to their default setting for the selected preference set.

OK Commits your changes to the preferences and closes the dialog.
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Paramet

er
Description

Cancel Undoes your changes to the preferences and closes the dialog.
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Recolour Drawings Dialog Box

The Recolour Drawing dialog box allows you to replace all instances of a colour or texture in drawings w ith a 

different colour or texture swatch in one of the scene's palettes. This replaces the colours or textures in the 

drawings w ithout requiring you to modify the palettes. You can use this dialog to perform colour replacement 

in the current drawing, in all the drawings in one or several layers or in all drawings in your scene.

This dialog w ill replace the colour or texture that is currently selected in the Colour view with the colour or 

texture that you select inside the dialog. 

How to access the Recolour Drawings dialog

 1. In the Colour view, select the colour or texture swatch you want to replace by doing one of the 

follow ing:

 l Select the palette in which the colour or texture swatch is located, then select the swatch 

you w ish to replace. 

 l If the drawing in the Camera or Drawing view contains the colour or texture you want to 

replace, select the Colour Eyedropper  tool in the Tools toolbar, then click on that colour 

or texture in the drawing. The Colour view will automatically select that colour or texture's 

palette as well as that colour or texture's swatch.
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 2. Do one of the follow ing:

 l Right-click on the swatches list, then select Recolour Drawings.

 l Open the Colour view menu , then select Colours > Recolour Drawings.

Parameter Description

Replace Colour In

Allows you to select which drawings w ill be affected by the colour replacement:

 l Current drawing: Replaces the selected colour in the currently selected 

drawing only.

 l All drawings in the currently selected layers: Replaces the selected 

colour in all the drawings in the layer that is currently selected in the 

Timelime or Xsheet view. 

NOTE 

This option can work w ith several drawing layers selected. 

 l All drawings in the scene: Replaces the selected colour in every drawing 

in the current scene.

Replacement Colour
Allows you to select the palette and colour or texture swatch to replace the 

selected colour or texture w ith.
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Remove Dirt Dialog Box

The Remove Dirt dialog box lets you select small dots and hairs on a drawing for removal.

W hen paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 

These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Dirt dialog box

 1. Do one of the follow ing:

 l From the top menu, select Drawing > Remove Dirt.

 l Press Shift + D.

Parameter Description

Slider

Lets you adjust the amount of detail removed from the layer. 

Raising the Remove Dirt level w ill select bigger dots. W hen selecting larger dots, 

be careful not to lose small details like pupils and nostrils. Once you have chosen 

the level, you can apply it to the current drawing or the entire animation 

sequence. This is a quick way to get rid of most dirt and dust.

During this process, the dirt that w ill be removed is highlighted in red.

Apply to all drawings Applies the operation to all drawings in the layer.
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Remove Hair Dialog Box

The Remove Hair dialog box lets you remove any small strokes created in the Colour Art layer from very thick 

lines or fil led zones. Increasing the Remove Hair level value w ill select larger strokes for removal from the 

drawing.

W hen paper drawings are passed through a scanner, there can be some hair and dirt scattered across them. 

These lines and dots need to be cleaned. Harmony provides different tools to help get rid of them quickly.

How to access the Remove Hair dialog box

 1. Select the drawing containing the drawing to clean.

 2. From the top menu, select View > Show Strokes to display the invisible lines or press K.

 3. In the top menu, select Drawing > Remove Hair.

Parameter Description

Slider Lets you adjust the number of length of hairs selected. 

Apply to all drawings Applies the operation to all drawings in the layer.
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Set Ease on Keyframes Dialog Box

The Set Ease on Keyframes dialog box allows you to quickly change the percentage of ease before and after a 

selection of keyframes. 

This dialog box is designed to quickly adjust the “time ratio” of the ease on your animations. To give you a 

better idea of its effect, select a keyframe and open the Set Ease for Multiple Paramters dialog box. This dialog 

box allows you to adjust the ease of your animations using Bezier handles. Moving the Bezier handle laterally 

changes the time ratio of the ease, and moving it vertically changes its value ratio—see Set Ease for Multiple 

Parameters Dialog Box.

How to access the Set Ease on Keyframes dialog box

 1. In the Timeline view, select one or several animation keyframes.

 2. In the Timeline toolbar, click on the  Set Ease on Selected Keyframes button.

The Set Ease on Keyframes dialog box appears.

Parameter Description

Ease In (left)
Allows you to adjust the ease left of the selected keyframes.

 l If the checkbox is unchecked, the ease left of the selected keyframes w ill be 
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Parameter Description

unchanged.

 l If the checkbox is checked, the ease left of the selected keyframes w ill be set to the 

percentage in the input-field right of the checkbox. 

Ease Out (right)

Allows you to adjust the ease right of the selected keyframes.

 l If the checkbox is unchecked, the ease right of the selected keyframes w ill be 

unchanged.

 l If the checkbox is checked, the ease right of the selected keyframes w ill be set to the 

percentage in the input-field right of the checkbox. 

OK Applies the selected changes and closes the dialog box.

Cancel Closes the dialog box w ithout making any changes.
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Tint Offset/Blend  Dialog Box 

You can offset, blend, or mix the colours in a colour palette using the sliders and increasing the Amount value.

How to access the Tint Offset/Blend dialog box

 1. From the Colour View  menu, select Palettes > Tint Panel or right-click and select Tint Panel.

The Blend/Offset Tint panel opens.

Parameter Description

Offset

Offsets the selected colours by the adjustments made using the HSB and RGB 

sliders. Use the Amount slider to adjust the degree of offset. Use the Alpha slider 

to adjust the opacity of the selected colour. 

Blend

Blends the selected colours w ith the colour swatch in the top-right corner. Use 

the Amount slider to adjust the degree of blend. A blend of 100% turns the 

selected colours into the same colour as the swatch. Adjusting the HSB and RGB 

sliders affect the swatch colour, which in turn affects the selected colours on the 

left. Use the Alpha slider to adjust the opacity of the swatch.

Mixer

Select a Base and Tint colour to form a third colour swatch. Use the slider just 

beneath to mix the Base and Tint colours by different amounts. This w ill affect 

the mixed swatch whether it is selected or not. Select either the Tint or Base 

swatch and use the HSB and RGB sliders to adjust its colour. This w ill affect the 

mixed swatch colour, which in turn affects the selected colours on the left.
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Toolbar Manager Dialog Box

The Toolbar Manager dialog box lets you customize the toolbar in any of the views. You can add your favourite 

tools to a toolbar for an efficient workflow.

How to access the Toolbar Manager dialog box

 1. Right-click on a toolbar in any view and select Customize. Note that the menu will not appear if 

you right-click on a disabled icon.

Parameter Description

Available Tools Displays the complete list of tools available for customizing a toolbar.

Toolbar Displays a list of the tools currently available on the toolbar.

Default Restores the toolbar w ith its default items.
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Chapter 2: Tools Properties

Harmony has a w ide variety of drawing and manipulation tools and each one of them has a series of options 

and modes available in the Tool Properties view. This section covers these options.  

Brush Tool Properties 58

Centerline Editor Tool Properties 81

Close Gap Tool Properties 83

Colour Eyedropper Tool Properties 84

Contour Editor Tool Properties 85

Cutter Tool Properties 90

Drawing Pivot Tool Properties 95

Edit Gradient/Texture Tool Properties 98

Ellipse Tool Properties 99

Envelope Tool Properties 109

Eraser Tool Properties 112

Ink Tool Properties 134

Line Tool Properties 136

Paint Tool Properties 148

Pencil Tool Properties 155

Pencil Editor Tool Properties 166

Perspective Tool Properties 171

Polyline Tool Properties 174

Rectangle Tool Properties 182

Reposition All Drawings Tool Properties 192
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Select Tool Properties 194

Shift and Trace Tool Properties 207

Smooth Editor Tool Properties 210

Stamp Tool Properties 212

Stroke Tool Properties 220

Text Tool Properties 222

Zoom Tool Properties 225
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Brush Tool Properties

The Brush tool allows you to draw by creating shapes based on your drawing strokes and fil l ing them with 

colour or textures. W hen used w ith a tablet, it is pressure sensitive, just like a real life brush.

How to access the Brush tool properties

 1. In the Tools toolbar, select the Brush  tool.

The tool's properties are displayed in the Tool Properties view.

Brush Properties

The follow ing properties affect the brush's size, smoothing and other properties for the drawing style of your 

brush. Those properties can be saved into brush presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.

Brush Properties Dialog The arrow button right of the preview area opens the Brush Properties dialog. 
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Property Description

W hile the Tool Properties view only gives you access to a few of the brush 

properties, a list of brush presets and other drawing options, the Brush Properties 

dialog gives you access to all the available options for your brush's tip and texture. 

For more information on the Brush Properties dialog, see the Brush Properties Dialog 

section below.

Maximum Size

Defines the maximum width of brush strokes.

If the tool is used w ith a pressure sensitive pen tablet, the w idth of the stroke w ill 

vary between its maximum size and minimum size depending on the amount of 

pressure used. If used w ith a mouse, the w idth of the stroke w ill always be its 

maximum size. 

Flow

Allows you to set the opacity for each instance of the brush tip that gets printed into 

your canvas. Contrary to the Opacity parameter, the flow parameter has a cumulative 

effect. This means that a lower flow will make your brush strokes more transparent 

towards its extremities and more opaque in its center. Your stroke's flow will also 

accumulate if you draw over it. By default, your brush's flow varies w ith the amount 

of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 

bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 

Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your 

whole brush stroke's opacity w ill not exceed the Opacity parameter. By default, the 

Opacity parameter varies depending on the amount of pressure you put on your 

tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 

bitmap layer.

Brush Presets

These options allow you to select, create and manage brush presets.
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Icon Property Description

  Presets list

By default, Harmony has preloaded brush presets. You can also create 

your own brush presets by configuring your brush, then saving its 

properties into a new preset. It is also possible to export and import 

brush presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the follow ing options:

 l New Brush Preset: Creates a new preset based on the current 

tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 

preset.

 l Import Brushes: Allows you to import brush presets exported 

from Harmony.

 l Export Brushes: Allows you to export your brush presets into 

an .xml file. 

 l Small Thumbnail: Displays presets in a grid of small 

thumbnails w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 
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Drawing Options

These options affect the way your drawing strokes are added to your artwork.

Icon Property Description

Draw Behind

W hen enabled, your brush strokes w ill appear behind the existing 

artwork. 

NOTE 

Your brush stroke w ill temporarily appear over your artwork as 

you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

W hen enabled, drawing a closed shape w ill automatically fil l it w ith the 

currently selected Paint colour. 

TIP 

By default the pencil l ine and its fil l w ill be the same colour. To 

select different colours for the line and its fil l, do the follow ing:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Brush Colour swatch. Then, in 

the colour list, select the desired colour swatch for your 

outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 

colour list, select the desired colour swatch for the fil l. 

Repaint Brush

W hen enabled, your brush strokes w ill only repaint existing artwork and 

w ill not add colour to empty areas. If you repaint semi-transparent 

artwork, your artwork w ill not become more opaque than it already is.
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Automatically Create 

Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art 

layer.

NOTE 

This option is only available when drawing on a vector layer.

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 

as a separate drawing object, which can be edited independently from 

other parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 

NOTE 

This option is only available when drawing on a vector layer. 

W hen drawing on a bitmap layer, artwork is always flattened. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping mode:

 l Snap to Alignment Guides: W hile drawing, the drawing tool 

w ill snap against nearby alignment guides.

Respect Protected 

Colour

In the Colour view, it is possible to make some of the colours in your 

palettes protected from change. W hen enabled, the Respect Protected 
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Colour option w ill prevent the brush tool from drawing over areas fil led 

w ith a protected colour.

NOTE 

This option is only available when drawing on a vector layer. 

W hen drawing on a bitmap layer, colour is not linked to your 

palettes and cannot be protected.

Use Stored Colour 

Gradient

The Use Stored Colour Gradient  option can be used when painting w ith 

a gradient colour to always position the gradient in the same way it was 

stored, making it consistent across brush strokes. You can store a 

gradient by selecting a zone painted w ith a gradient w ith the Select tool, 

then clicking on Store Colour Gradient  in the Tool Properties view.

NOTE 

This option is only available when drawing on a vector layer.

Brush Properties Dialog

Brushes have an extensive set of options and properties that are not displayed in the Tool Properties view, but 

rather, in a dialog you can access from it. To open the Brush Properties dialog, click on the arrow button right 

of the stroke display area. 

The Brush Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 

layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 63

 l Smoothing Tab    on page 70

 l Transparency Tab on page 71

 l Dual Tip Tab on page 75

 l Paper Texture Tab on page 78

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your brush tip.
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NOTE 

The "Size Proportional to Camera" option has been moved to the new Size Properties w indow.

Property Description

Brush Type

Allows you to select between one of the follow ing brush types:

 l Solid Vector Brush: Creates vector shapes fil led w ith a solid colour. 

Makes artwork lightweight, scalable and easy to tweak. Since this kind of 

brush can only create solid colour shapes, solid vector brushes have a 

limited set of options including size, roundness, angle, centerline 

smoothing and contour smoothing.

 l Textured Vector Brush: Creates vector shapes fil led w ith a texture. This 

gives you access to bitmap brush tips, paper textures, transparency and 

several other options.
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NOTE 

This option is not available when working on a bitmap layer. W ith bitmap 

layers, brushes are always textured, and textured brush options are always 

available.

Brush Tip Library

This is where you select the shape of the brush tip. By default it is round. Note 

that some tips are designed to have semitransparent areas, even when the 

maximum brush opacity is set to 100%.

To create a custom brush tip, you must prepare the file ahead of time, either in 

Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 

supported and transparency is not supported in the traditional sense. Black 

appears as 100% opaque, white appears as 100% transparent and all the 

shades of grey in between appear as varying degrees of semitransparency. A 

range of file formats are supported—.jpeg, .png, .tif, .psd, .tga to name a few. 

Alpha channels are disregarded on import. It is recommended that your file be 

between 100 x 100 pixels and 400 x 400 pixels. 

You can also import brush tips that you exported from Harmony, so you can 

share them with colleagues.

Minimum and Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and 

thin effect on your stroke. This works w ith the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  w idth of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to 

and as a percentage of the maximum size.

You can control the size properties by clicking on the arrow button on right and 

the dialog box w ill appear as shown below.
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 l Pressure: Allows you to apply more pressure and increases the size of 

the brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can 

check the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast 

speed.  You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 

drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the 

end of each stroke. The value can be expressed using two options: 

Distance and Percentage. Distance is selected by default. For example: 

A taper of 200 w ill be the same length as the w idth (diameter) of a stroke 

that has its size set at 200.

You can enable Start and End Tapering option individually.

 l Start Taper: W hen distance is selected as a Taper value, the effect of 

start taper can be visualized as the stroke is drawn. 

 l End Taper: W hen distance or percentage is selected as a Taper value,  

the effect of end taper can be visualized once the stroke is complete and 

vectorized as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given 

distance. It uses the same units as the size and is applied as the stroke is 

drawn.

 l Size Proportional to Camera: If you check this option, the size of the  w ill 

be adjusted to the position of the camera on the z-axis. This means that if 
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the camera is zoomed in on the scene, the  w ill be proportionally smaller 

so that it appears the same size in the rendered image. Likewise, if the 

camera is zoomed out, the  w ill be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of 

creating w idth variation on your stroke. In other words, you would be 

forcing a uniform line w idth using the Maximum Size value.

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and 

orientation of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 

squashes the tip vertically, allow ing you to turn round or square tips into 

flat tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the 

squashing w ill stil l be done relative to the tip's original orientation.

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set 

whether your brush takes your pen's tilt angle into account, and how much. 

W hen your pen is fully tilted, your brush tip w ill be stretched by the percentage 

you set in this parameter, in the angle in which you tilt it. For example, if you set 

the Pen Tilt Sensitivity to 50%, and you tilt your pen all the way up or down, your 

brush tip w ill be stretched vertically by 50%. W ith the same setting, if you tilt 

your pen all the way left or right, your brush tip w ill be stretched horizontally by 

50%.
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Angle Function

If enabled, your brush tip w ill rotate w ith the angle of your pen tip. You can select 

one of the follow ing options:

 l Constant: The static orientation of the brush tip expressed in degrees.

 l Heading: The orientation of the brush tip is determined by the direction in 

which the stroke is drawn. It changes dynamically as the stroke is drawn.

 l Azimuth: W hen the pen is tilted, it uses the direction in which the pen 

eraser is facing.

 l Twist (if supported by pen): It uses the tw ist angle of the stylus and is 

only available w ith W acom Art Pen.

Hardness

The hardness value corresponds to the softness of the brush tip's edges. The 

lower the value, the softer the tip edge. The higher the value, the sharper the tip 

edge. Be aware that some brush tips are not 100% opaque, so they w ill always 

appear somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the brush. A value of 100% 

sets the stamp marks edge to edge, if there is no white space around the shape. 

The larger the value, the greater the space between marks. A really large value 

can make the brush stroke appear as a string of individual marks. Conversely, a 

small spacing value w ill give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 
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Random Size

You can create variation between the thick and thin of your brush stroke just by 

setting the Maximum and Minimum Size values. If you add randomness to the 

mix, pressure sensitivity from your drawing tablet w ill stil l be applied. Light 

pressure w ill create random values around the minimum, while heavy pressure 

w ill create random values closer to the maximum. The larger the percentage, the 

larger the range of random variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating 

w idth variation on your stroke, whether you are applying randomness or 

not. Therefore, you would be forcing a uniform line w idth using the 

Maximum Size value.

Random Angle

Sets the range for random rotation around the set Angle value. For example, if 

the Angle is set to 45° and the Random Angle set to 10°, the software w ill 

choose values between 40°–50° (plus or minus 5 degrees, equaling a total of 10 

degrees).
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Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if 

the Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony 

w ill choose values between 45%–55% (plus or minus 5 percent, equaling a total 

of 10 percent).

Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your brush 

strokes as you paint. 
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NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 

support smoothing.

Property Description

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

brush stroke. A higher setting w ill prevent your line from being shaky, but is liable to 

reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the brush stroke. A higher setting w ill round sharp corners and reduce the amount of 

control points for the resulting vector shape. 

Transparency Tab

The Transparency tab allows you to decide if your brush has antialiasing as well as to set its flow and opacity 

settings. 
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NOTE 

The Transparency tab's options are only available on vector layers if the Brush Type option of the 

Tip tab is set to Textured Vector Brush. On bitmap layers, those options are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the brush strokes to blend 

w ith the surrounding colours, to create an il lusion of smoothness otherwise not 

possible due to the picture resolution.

If antialiasing is disabled, the brush's texture w ill only render fully transparent or 

fully opaque pixels. Disabling this option can be useful if you need your outlines 

to be very crisp, if you want to make pixel art or if you need your brush strokes to 

render in solid colors w ith no variation, which makes them easier to repaint or 

process in third party software.

NOTE 

W hen disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate 

at which paint flows from your brush. The analogy works better w ith a pen. The 

greater the flow, the more ink comes out, hence the more consistent the colour 

and texture of the line. If the flow is light,  then the colour and texture of the line 

may look spotty. This feature works w ith the pressure sensitivity of a pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture are 

applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 

applied as you create a fluid stroke. It is defined as a percentage of the 

Maximum Flow value. If the Minimum Flow value is set to 100%, then 

tablet pressure sensitivity w ill no longer be applicable. The flow will be 

set to the constant rate of the Maximum Flow value.

You can control the flow properties by clicking on the arrow button on right and 

the dialog box w ill appear same as shown for size properties above. Minimum 
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and Maximum Size on page 65.

Maximum Opacity and 

Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity 

range for a brush mark. This works w ith the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the brush mark when 

the pressure is heavy. 

 l Minimum Opacity: Sets the transparency limit of the brush mark when 

the pressure is very light. It is defined as a percentage of the Maximum 

Opacity value. If the Minimum Opacity value is set to 100%, then tablet 

pressure sensitivity w ill no longer be applicable. The opacity w ill be set 

to the constant rate of the Maximum Opacity value.

You can control the opacity properties by clicking on the arrow button on right 

and the dialog box w ill appear same as shown for size properties above. Please 

refer Minimum and Maximum Size on page 65

Randomness
Th Randomness parameter lets you set the range for the randomness of the flow 

and opacity. This works w ith the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your brush stroke just by setting the 

Maximum and Minimum Flow values. If you add randomness to the mix, pressure 

sensitivity from your drawing tablet w ill stil l be applied. Light pressure w ill 

create random values around the minimum, while heavy pressure w ill create 

random values closer to the maximum. The larger the percentage, the larger the 

range of random variation. 
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NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of 

creating flow variation on your stroke, whether you are applying 

randomness or not. That is, you would be forcing a uniform flow using the 

Maximum Flow value.

Random Opacity

You can create variation in the opacity of your brush stroke just by setting the 

Maximum and Minimum Opacity values. If you add randomness to the mix, 

pressure sensitivity from your drawing tablet w ill stil l be applied. Light pressure 

w ill create random values around the minimum, while heavy pressure w ill create 

random values closer to the maximum. The larger the percentage, the larger the 

range of random variation.
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NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of 

creating opacity variation on your stroke, whether you are applying 

randomness or not. That is, you would be forcing a uniform opacity using 

the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip brush. The primary bitmap brush tip and 

the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 

the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 

Additionally, if you are working on a vector layer, the Brush Type option of the Tip tab must be set 

to Textured Vector Brush. 

Property Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your brush uses a 

dual tip. If this checkbox is unchecked, the options in the Dual Tip tab w ill be 

disabled. 

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. W hen the two brush tips are combined in this mode, 

they essentially cut each other out in overlapping areas, where one or both tips have 

an area of 100% transparency. The less opaque the brush tips are, the lighter their 

combination. 

Colour Dodge

In this mode, the primary tip cuts out the shape of the dual tip. W here the tip shapes 

overlap, w ithin the boundaries of the primary shape, the colour and opacity appear 

darker.
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Property Description

Combine
This mode treats the two tips as two different and separate brushes that have the 

same colour and follow the same path.
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Property Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper- like texture for your brush. You can also add textures by 

importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 

Texture tab. Additionally, if you are working on a vector layer, the Brush Type option of the Tip 

tab must be set to Textured Vector Brush. 

Property Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your brush uses a 

paper texture. If this checkbox is unchecked, the options in the Paper Texture tab w ill 

be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive

This option layers the texture on top of itself as you scribble overlapping lines in one 

continuous stroke.  If this option is turned off, areas of overlapping lines from a single, 

continuous stroke w ill appear the same, in terms of darkness and texture, as non-
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Property Description

overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 

enabled, the paper texture's position does not change w ith each sweep of the brush. 

If this option is disabled, each sweep of the brush produces a different texture 

position. The texture orientation always stays the same.
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Centerline Editor Tool Properties

The Centerline Editor tool allows you to edit brush strokes by their centreline rather than by their contour.  This 

makes it easier to tweak the tips, curves and corners of brush strokes. The purpose of this tool is to make it as 

easy to edit brush strokes as it is to edit pencil l ines w ith the Contour Editor tool.

How to access the Centerline Editor tool properties 

 1. In the Tools toolbar, select the Centerline Editor  tool.

 2. The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 

elements:

 l Lasso: Allows you to select multiple elements by 

drawing an irregular closed shape around them with 

your mouse.

 l Marquee: Allows you to select multiple elements 

by drawing a rectangle around them. This is faster, as 

you only need to drag your mouse from one corner of 

the rectangle to its opposite corner, but it may not be as 

precise as you want.

TIP 

You can press and hold the Alt key to temporarily use 

the other selection mode.

Show Centerline Editor Controls

W hen enabled, selecting several control points w ill make a 

manipulator bounding box appear. You can use this 

manipulator to scale and rotate the selection of points.
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Icon Property Description

Apply to Line and Colour Art

Allows you to perform drawing operations on both the Line Art 

and Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, 

they w ill also be affected when this option is enabled.

  Centerline Smoothness

Allows you to adjust the amount of control points on the 

centreline that is generated from the selected stroke. A lower 

value w ill create a centreline w ith less points, which makes it 

easier to manipulate large lengths of the stroke, and a higher 

value w ill generate a centreline w ith more points, allow ing you 

to tweak details. 
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Close Gap Tool Properties

The paint tool requires the area you attempt to fil l to be closed in order to know exactly what area of your 

artwork must be fil led. However, it is common for artists to accidentally leave small gaps in their artwork. 

The Close Gap tool allows you to quickly close small gaps in a shape by creating an invisible stroke connecting 

two extremities of the gap. You can then fil l the area using the Paint tool, as this invisible stroke w ill be taken 

in account to determine the outline of the shape to fil l. 

TIP 

You do not need to use the Close Gap tool w ith precision. If you draw a crude stroke near the gap 

you want to close, the tool w ill automatically detect the two closest line extremities and w ill draw 

an invisible straight line connecting them. closing the gap between them. 

How to access the Close Gap tool properties

 1. In the Tools toolbar, select the Close Gap  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Auto Flatten

The Close Gap tool creates an invisible drawing stroke to close the shape. 

Enabling this option w ill merge the stroke into the artwork instead of adding the 

stroke on top of it.

NOTE 

The area you close w ith the Close Gap tool w ill be fil lable regardless of 

whether or not this option is enabled.
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Colour Eyedropper Tool Properties

The Colour Eyedropper tool allows you to pick a colour from your drawing w ithout going to the Colour view. 

NOTE 

The follow ing options w ill only have an effect when picking colours from a bitmap layer, as they 

affect the colour that gets picked. W hen working on a vector layer, you can only pick colours that 

are available in one of the palettes in your scene. Therefore, the colour you pick w ill always be 

exactly the colour that was used to fil l the shape or stroke you clicked on.

How to access the Colour Eyedropper tool properties

 1. In the Tools toolbar, select the Colour Eyedropper  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

Sample All Layers

By default, the Colour Eyedropper tool picks the colour from the active 

drawing layer only. This means that if the colour is semi-transparent, it w ill 

stil l only take the colour from the active layer, along w ith its transparency, 

and ignore the colours from layers behind it. 

W ith this option enabled, the Colour Eyedropper tool w ill pick the colour as 

it appears on the screen instead, allow ing you to pick colours that are the 

result of several layers composited together.

Do Not Pick 

Transparency

By default, the Colour Eyedroppertool picks the colour's alpha value as well 

as its colour values. W hen enabled, the colour picked w ill always have an 

alpha value of 255.
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Contour Editor Tool Properties

The Contour Editor lets you reshape vector shapes, brush strokes and lines in your drawings. 

Artwork in Harmony is made of vector shapes. Vector shapes are defined by points, the lines joining the points 

together (contours) and the curve vectors, represented by Bezier handles, which make the curve of said lines.

The Contour Editor tool allows you to select a contour or point, and change the position of points, add and 

remove points from the shape, rotate, lengthen and shorten curve handles to influence the curve of contours 

between those points, or drag contours between points to change their curve directly. 

How to access the Contour Editor tool properties

 1. In the Tools toolbar, select the Contour Editor  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Modes

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 

elements:

 l Lasso: Allows you to select multiple elements by 

drawing an irregular closed shape around them with your 

mouse.

 l Marquee: Allows you to select multiple elements by 
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Icon Property Description

drawing a rectangle around them. This is faster, as you only 

need to drag your mouse from one corner of the rectangle to 

its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the 

other selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to 

select which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can 

also click on this button to toggle it off, which w ill disable all 

snapping modes, and click on it again and toggle it on to re-enable 

the snapping modes which were previously enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hen enabled, moving the control point 

in a contour near another contour w ill snap that control 

point against that contour. This w ill lock the point and the 

contour together, and moving the control point w ill deform 

the contour. 

This option can be especially useful if you need to makes the 

edges of two shapes snap together, l ike so:

You can also use this option to make a control point snap 

against another control point, allow ing you to join lines 

together.
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Icon Property Description

NOTE 

W hen a control point is snapped against a contour 

or another control point in your drawing, the Contour 

Editor w ill manipulate them together. However, 

even if you make a point in one drawing stroke snap 

against another drawing stroke, they w ill remain 

separate drawing strokes unless they are flattened 

together, and you w ill stil l be able to manipulate 

them individually w ith the Select tool. 

 l Snap to Alignment Guides: W hile moving the selection or 

one of its control points, it w ill snap against nearby 

alignment guides.

 l Snap and Align: Snaps the selected anchor point to any 

existing line while displaying temporary rulers as a guide 

that you can also snap your anchor point to. 

 l Snap to Grid: W hile moving the selection, the mouse cursor 

w ill snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 

from the top menu or press Ctrl + '.

Show Contour Editor 

Controls

W hen enabled, selecting several control points w ill make a 

manipulator bounding box appear. You can use this manipulator to 

scale and rotate the selection of points.

Tip Style

If you select and remove part of a pencil l ine, this option allows you 

to choose which kind of line tip the removed segment should leave 

behind:
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Icon Property Description

 l  Tip Style: Round: Leaves rounded tips at the extremities 

of the deleted line segment.

 l  Tip Style: Flat: Leaves flat tips at the extremities of the 

deleted line segment.

Apply to Line and Colour 

Art

Allows you to perform drawing operations on both the Line Art and 

Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they 

w ill also be affected when this option is enabled.

Operations

Icon Property Description

Smooth Selection

The Smooth operation lets you smooth out selected drawing 

strokes and remove extra points.

TIP 

You can also smooth the selection by selecting Selected  > 
Smooth from the top menu or by pressing Alt + Shift + S.             

Split Pencil Line 
W hen drawing w ith the Polyline tool, your drawing has an even line 

thickness. You can use the Pencil Editor to adjust the thickness point 
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Icon Property Description

Join Pencil Lines

by point, but if you want to adjust it quicker, you can use the Split 

Pencil Line and Point Pencil Lines options to create segments and 

apply a pencil stencil to your drawing. Note that if you did not join 

the pencil l ines on your polyline stroke, the segments between the 

points w ill act as separated segments.
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Cutter Tool Properties

The Cutter tool lets you cut out part of a drawing so that you can transform it, copy it or delete it. It also allows 

you to trim overshot lines.

How to access the Cutter tool properties

 1. In the Tools toolbar, click and hold on the Select  tool to display the menu beneath and select 

the Cutter  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 

irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 

rectangle around them. This is faster, as you only need to drag your 

mouse from one corner of the rectangle to its opposite corner, but it 

may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 

selection mode.

Easy Drag

W hen enabled, you can drag the selection by clicking anywhere inside its 

bounding box. By default, you must click on the artwork in the selection to be 

able to drag it. 
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Use Mouse 

Gesture 

W hen this option is enabled along w ith the Lasso  selection type, quickly 

drawing a line w ith the Cutter tool over a line segment in your artwork w ill 

instantly delete it. This can be useful if you want to use the Cutter tool to 

quickly clean up your artwork. 

It allows you to cut in two modes as follows:

 l Single Line Cutting Gesture: It deletes first l ine segment over which 

a straight gesture is drawn with the cutter.

 l Multiple Lines Cutting Gesture: It deletes all l ine segments over 

which a straight gesture is drawn with the cutter.

NOTE 

This option w ill only work when using the Cutter tool on separate 

brush or pencil strokes. Hence, it is important not to flatten your 

artwork if you intend to use this option to clean up your drawings. This 

option has no effect on bitmap layers as the artwork in bitmap layers is 

always flattened.

Use Mouse 

Gesture Breaker 

Mode

W hen using the Lasso  selection type, the Use Mouse Gesture Breaker Mode  

option lets you draw an invisible stroke on a pencil l ine to cut it in two 

individual objects. Once a pencil l ine is cut w ith this option, you w ill be able 

to select the two portions independently w ith either the Cutter tool, Pencil 

Editor tool or Select tool.
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NOTE 

This option only works w ith pencil l ines.

Tip Style

W hen cutting through pencil l ines, this option decides what kind of pencil 

l ine tips to put at the extremities of the remaining pencil l ine segments, 

where they were cut. 

By default, this is set to Bevel , which w ill leave the tip of the pencil l ine 

cut at the same angle as your cutter stroke. If you prefer, you can make pencil 

l ines that you split w ith the Cutter tool have Flat  or Round  tips 

instead. 

Antialiasing

W hen working on bitmap artwork, enabling this w ill smooth the edges of the 

artwork you cut out, so that they do not appear pixelated. 

NOTE 

This option is only available w ith bitmap layers.

Apply to Visible 

Drawing Layers

This option allows you to select which layers the tool should affect. It can be 

toggled on or off. W hen toggled on, it has two different modes. You can 

select a mode by clicking and holding on the button.
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 l Off: W hen this button is toggled off, the tool only works on the 

currently selected layers. If several layers are selected, the tool w ill 

work on all these layers simultaneously. 

 l On W hen this button is toggled on, the tool w ill work on all the 

visible layers.

 l  Apply to Visible Drawing Layers: The tool w ill work on all the 

visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer 

is synced w ith another layer, the tool w ill work on both the current 

layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All 

Frames

This option allows you to determine which drawings in the current layer the 

tool should affect. It can be toggled on or off. W hen toggled on, it has two 

different modes. You can select a mode by clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on the 

drawing in the current frame.

 l Apply to All Frames: The tool w ill work on every exposed 

drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool w ill work on every drawing 

displayed in the Onion Skin. Onion Skin must be enabled for this 

option to work. 

Apply to Line and 

Colour Art

Allows you to perform drawing operations on both the Line Art and Colour 

Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they w ill also be 

affected when this option is enabled.

Operations

Icon Property Description
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Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees 

CW
Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees 

CCW
Rotates the current selection 90 degrees counter-clockwise.
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Drawing Pivot Tool Properties

The Drawing Pivot  tool lets you set the pivots on your character. You can set the drawing pivots on drawings 

and symbols.

Tool Options

Icon Property Description

Setting the Drawing Pivot for Symbols on 

All Frames

The Set the Pivot for Symbol on All Frames  option 

is enabled by default. W hen you set a drawing 

pivot on a symbol, all of its cells use the same 

drawing pivot. This means you do not have to set a 

drawing pivot on all frames. Once you set it, it is 

done.

If you prefer to set a different drawing pivot for a 

series of cells, you can deselect the option and set 

your pivots on each cell or cell range.

NOTE 

If you have already set several different 

pivots on your symbol's cells and selected 

the Set the Pivot for Symbol on All 

Frames option, once you set a new pivot 

on the same symbol, all of its pivots w ill 

be reset and w ill use your new pivot.

Snapping

Allows you to enable or disable snapping for this 

tool and all other animation and drawing tools that 

support snapping, as well as to select which types 

of snapping are enabled. 

If you double-click or long-click on this button, it 

w ill open a pop-up menu in which you can toggle 

different snapping modes. You can also click on 

this button to toggle it off, which w ill disable all 

snapping modes, and click on it again and toggle it 
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Icon Property Description

on to re-enable the snapping modes which were 

previously enabled. 

This tool supports the follow ing snapping modes :

 l Snap to Contour: W hen moving the pivot, 

it w ill snap against the nearby points and 

contours of your artwork.

 l Snap to Alignment Guides: W hen moving 

the pivot, it w ill snap against nearby 

alignment guides.

 l Snap and Align: W hen moving the pivot, it 

w ill align w ith the edges of elements in the 

drawing.

 l Snap to Grid: W hen moving the pivot, it 

w ill snap against the intersecting points of 

the grid. 

TIP 

To display the grid, select View > 
Grid > Show Grid from the top 

menu or press Ctrl + '.

Reset Pivot

W hen you click the Reset Pivot  option, the drawing 

pivot of the selected drawing or symbol is reset to 

the centre of the Camera view.

Copying Pivot on Parent Symbol

W hen you import new extra drawings, such as 

hands and mouths, you can use the drawing pivot 

that was set on your drawings and report them to 

the symbol's cells. Use the Copy Pivot to Parent 

Symbol   command for this.
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NOTE 

W hen you copy drawing pivots to the 

parent symbol, there is no link between 

the drawings' pivots and the symbol's 

pivots. If you modify the drawing pivot 

later, it w ill not link to the symbol. You 

would need to perform the operation 

again. If you need to modify the symbol's 

pivots, you can do it directly on the 

symbol's cells.
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Edit Gradient/Texture Tool Properties

The Edit/Gradient Texture tool allows you to move, rotate and scale a gradient or texture fil l w ithin the shape 

it fil ls, w ithout modifying the shape itself. 

How to access the Edit Gradient/Texture tool properties

 1. In the Tools toolbar, select the Edit Gradient/Texture  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Property Description

Apply to Visible 

Drawing Layers

This option allows you to select which layers the tool should affect. It can be 

toggled on or off. W hen toggled on, it has two different modes. You can 

select a mode by clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on the 

currently selected layers. If several layers are selected, the tool w ill 

work on all these layers simultaneously. 

 l On W hen this button is toggled on, the tool w ill work on all the 

visible layers.

 l  Apply to Visible Drawing Layers: The tool w ill work on all the 

visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected layer 

is synced w ith another layer, the tool w ill work on both the current 

layer and its synced layer. 

NOTE 

This option only works in the Camera view. 
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Ellipse Tool Properties

The Ellipse tool allows you to quickly draw an ellipse or a circle.

How to access the Ellipse tool properties

 1. In the Tools toolbar, select the Ellipse  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil l ines. Hence, its tool properties are similar to the ones of the 

Pencil tool and it can be used w ith pencil presets.
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Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.

Pencil Properties 

Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

W hile the Tool Properties view only gives you access to a few of the pencil properties, 

a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 

access to all the available options for your pencil 's shape and texture. For more 

information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 

104 section below.

Size Defines the w idth of the pencil l ine used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 

can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can choose 

between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.
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  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 

also lets you create and save your own. It is a good idea to create and 

save pencils w ith precise sizes and parameters when you draw for 

efficiency and consistency.

A thickness stencil saves the thickness information across the length of 

the line.  W hen drawing w ith a thickness stencil, the pressure sensitivity 

of the tablet is discarded. A thickness stencil can be used while drawing, 

or applied afterwards.

You also have the possibility to apply different textures to your lines by 

either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 

those that others have created. This is a good way for you and project 

collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the follow ing options:

 l New Brush Preset: Creates a new preset based on the current 

tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 

preset.

 l Import Brushes: Allows you to import brush presets exported 

from Harmony.

 l Export Brushes: Allows you to export your brush presets into an

 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 

w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 

Drawing Options

These options affect the way your shape is added to your artwork.
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Draw Behind

W hen enabled, your brush strokes w ill appear behind the existing 

artwork. 

NOTE 

Your brush stroke w ill temporarily appear over your artwork as 

you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

W hen enabled, the shape you draw is automatically fil led w ith the 

selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil l ine and its fil l w ill be the same colour. To 

select different colours for the line and its fil l, do the follow ing:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 

the colour list, select the desired colour swatch for your 

outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 

colour list, select the desired colour swatch for the fil l. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 
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modes which were previously enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hen enabled, while you're drawing, the 

mouse cursor w ill snap to the nearby contours of the artwork in 

your drawing. 

 l Snap to Alignment Guides: W hile drawing, the drawing tool 

w ill snap against nearby alignment guides.

 l Snap and Align: W hen enabled, while you're drawing, the 

mouse cursor w ill automatically align to the rectangular 

bounding boxes of other strokes and shapes in your drawing.

 l Snap to Grid: W hile moving the selection, the mouse cursor w ill 

snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid from 

the top menu or press Ctrl + '.

Automatically Create 

Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art 

layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 

as a separate drawing object, which can be edited independently from 

other parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can use select and remove a segment of 

flattened pencil l ines. Overlapping pencil l ines drawn with the 

Auto-Flatten mode are essentially cut into segments by the 

overlap and can be treated as individual lines.

Use Stored Colour 

Gradient

The Use Stored Colour Gradient  option can be used when painting w ith 

a gradient colour to always position the gradient in the same way it was 

stored, making it consistent across brush strokes. You can store a 

gradient by selecting a zone painted w ith a gradient w ith the Select tool, 

then clicking on Store Colour Gradient  in the Tool Properties view.

Draw Circle

W hen enabled, the ellipsis tool w ill always draw an ellipsis of equal 

w idth and height, making it a perfect circle.

TIP 

You can also draw a perfect circle by holding the Shift key while 

drawing.

Pencil Properties Dialog

The Ellipse tool draws the same type of line as the Pencil tool. Hence, you can configure the Ellipse tool's lines 

using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 

display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil 's size, its smoothing parameters as well as the 

shape of its tips and corners. 
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Maximum Size

Defines the maximum size of the pencil l ine. If the tool is used w ith a pressure 

sensitive pen tablet, the w idth of the stroke w ill vary between its maximum size and 

minimum size depending on the amount of pressure used. If used w ith a mouse, the 

w idth of the stroke w ill always be its maximum size. 

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you 

do not have pressure sensitivity from a pen table, the minimum size value w ill be 

ignored. 

Proportional to Camera

If you check this option, the size of the pencil w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

pencil w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the pencil w ill be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

pencil stroke. A higher setting w ill prevent your line from being shaky and w ill reduce 

the amount of control points it has, making it easier to tweak, but is liable to reduce 

drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the pencil stroke. 

A pencil l ine is defined by its centreline and its variations in thickness, rather than its 

apparent shape. W hen drawing a pencil l ine w ith a mouse, its thickness is uniform. 

Therefore, its outer contour does not have any control point, except at its extremities, 

and no smoothing is required for its contour. 

However, when drawing a pencil l ine w ith a pressure sensitive tablet, its contour w ill 

have control points and Bezier curves to define the line's variations in thickness, and 
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thus smoothing must be performed on its contour. An increased contour smoothing 

w ill reduce the amount of control points on the line's thickness and smoothen its 

curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can 

choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 

pencil texture palette to use w ith the Pencil tool. You can also add, remove or rename textures, save the 

current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 

Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 

Colour view—see Colour View  on page 239. 
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Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 

texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 

the current pencil texture palette. The pencil texture's effect on your 

pencil l ine w ill be based on the image's transparency channel, and w ill 

follow your pencil l ines on its horizontal axis. This option is also 

available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 

This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 

texture palette. This option is also available from the menu button.

  Pencil Texture Display Displays the pencil textures in the current pencil texture palette and 
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allows you to select one to use w ith the Pencil tool.

  Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for 

reference. To select a different pencil texture palette, you must select it 

in the Colour view—see Colour View  on page 239.
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Envelope Tool Properties

Selecting the Envelope tool displays its properties and options in the Tool Properties view. 

Icon Tool Name Description

 
W idth and 

Height

Increase the w idth and height values to add more columns and rows to the 

deformation grids.

Lasso

Sets the selection mode to Lasso, which allows you to select multiple items by 

drawing a lasso around them.

TIP 

W hen this option is enabled, you can press and hold the Alt key to 

temporarily use Marquee mode.

Marquee
Sets the selection mode to Marquee, which allows you to select multiple items 

by drawing a rectangle around them. 
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TIP 

W hen this option is enabled, you can press and hold the Alt key to 

temporarily use Lasso mode.

Snapping

Allows you to enable or disable snapping for this tool and all other animation 

and drawing tools that support snapping, as well as to select which types of 

snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up menu in 

which you can toggle different snapping modes. You can also click on this 

button to toggle it off, which w ill disable all snapping modes, and click on it 

again and toggle it on to re-enable the snapping modes which were previously 

enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hile moving the selection or one of its control 

points, it w ill snap against the nearby points and contours of your 

artwork, allow ing you to snap parts of your artwork together. 

 l Snap to Alignment Guides: W hile moving the selection or one of its 

control points, it w ill snap against nearby alignment guides.

 l Snap and Align: W hen enabled, while moving a selection, the 

rectangular bounding box of the selection w ill snap to the rectangular 

bounding box of any other drawing stroke in the drawing, allow ing you 

to align drawing strokes laterally.

 l Snap to Grid: W hile moving the selection, the mouse cursor w ill snap 

against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid from the top 

menu or press Ctrl + '.

Show Advanced 

Controls
To display more controls,you can click on the Show Advanced Controls  button.
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Apply to Line 

and Colour Art

Allows you to perform drawing operations on both the Line Art and Colour Art 

layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they w ill also be 

affected when this option is enabled.

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 

Degrees CW
Rotates the current selection 90 degrees clockwise.

Rotate 90 

Degrees CCW
Rotates the current selection 90 degrees counter-clockwise.

Smooth

You can modify the central l ine smoothness  of your line using this option. This 

parameter smooths the deformed lines. Increasing the value w ill result in a 

smoother line w ith fewer control points. The more you increase the value, the 

less details and curves you w ill get. Use the left and right arrows to increment 

the value by one full unit. Use the Up - Down slider to quickly increment the 

value.
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Eraser Tool Properties

The Eraser tool allows you to erase artwork by drawing eraser strokes over it. W hen using the Eraser tool w ith 

a tablet, it is pressure sensitive, like w ith the Brush and Pencil tool. 

How to access the Eraser tool properties

 1. In the Tools toolbar, select the Eraser  tool.

The tool's properties are displayed in the Tool Properties view.

Eraser Properties

The way the Eraser tool is configured is almost identical to the way the Brush tool is configured.

Property Description

Stroke Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.

Eraser Properties 

Dialog

The arrow button right of the display area opens the Eraser Properties dialog, which 

gives you access to all the parameters and options for your eraser. The Tool Properties 
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view only gives you access to a few of the eraser properties, a list of eraser presets and 

options for the Eraser tool that are  not related to the eraser properties. For more 

information on the Eraser Properties dialog, see the Eraser Properties Dialog section 

below.

Maximum Size

Defines the maximum size of the eraser. 

If the tool is used w ith a pressure sensitive pen tablet, the w idth of the stroke w ill vary 

between its maximum size and minimum size depending on the amount of pressure 

used. If used w ith a mouse, the w idth of the stroke w ill always be its maximum size. 

Flow

Lets you set the opacity for each instance of the eraser tip that gets erased from your 

artwork. Contrary to the Opacity parameter, the flow parameter has a cumulative effect. 

This means that a lower flow will make your eraser strokes less effective towards its 

extremities and more effective in its center. Your stroke's flow will also accumulate if 

you draw over it. By default, your eraser's flow varies w ith the amount of pressure you 

put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 

bitmap layer.

Opacity

The Opacity parameter are where Lets you set the opacity of your brush strokes. 

Contrary to the Flow parameter, the Opacity parameter is non-cumulative. Your whole 

brush stroke's opacity w ill not exceed the Opacity parameter. By default, the Opacity 

parameter varies depending on the amount of pressure you put on your tablet pen.

NOTE 

This option is only displayed in the Tool Properties view when drawing on a 

bitmap layer.

Eraser Presets

These options allow you to select, create and manage eraser presets.
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  Presets list

By default, Harmony has preloaded eraser presets. You can also 

create your own eraser presets by configuring your eraser, then 

saving its properties into a new preset. It is also possible to export 

and import eraser presets. 

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail
Displays presets in a grid of small thumbnails w ith a preview of their 

tip.

  Large Thumbnail
Displays presets in a grid of big thumbnails, w ith their name and a 

preview of their tip.

  Stroke View
Displays presets in a list, w ith their name and a preview of a stroke 

done w ith each preset. 

Erasing Options

These options affect the way your eraser strokes are applied to your artwork.

Icon Property Description

Apply to Line and 

Colour Art

Allows you to perform drawing operations on both the Line Art and 

Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they w ill 

also be affected when this option is enabled.
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Tip Style

W hen you erase part of a pencil l ine, this option determines the shape of 

the extremity of the pencil l ine where you erased:

 l  Round:  Leaves a round tip at the extremities of the pencil 

l ine you erased.

 l  Flat: Leaves a flat tip at the extremities of the pencil l ine you 

erased. A flat tip is always perpendicular to the angle of the 

centreline of the pencil l ine, so it may not match the angle of your 

eraser stroke. 

 l  Bevel: Leaves a bevel tip at the extremities of the pencil l ine 

you erased. A bevel tip is flat, but its angle matches the angle of 

your eraser stroke.

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping mode:

 l Snap to Alignment Guides: W hile erasing, the eraser w ill snap 
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against nearby alignment guides.

Apply to Synced 

Drawing Layers

If the currently selected layer is synced w ith another layer, the tool w ill 

work on both the current layer and its synced layer. 

Eraser Properties Dialog

Erasers have an extensive set of options and properties that are not displayed in the Tool Properties view, but 

rather, in a dialog you can access from it. To open the Eraser Properties dialog, click on the arrow button right 

of the stroke display area. 

The Eraser Properties dialog has five different tabs, minus the Smoothing tab if you are working on a bitmap 

layers. Below is detailed information about the options available in each tab:

 l Tip Tab on page 116

 l Smoothing Tab    on page 123

 l Transparency Tab on page 124

 l Dual Tip Tab on page 127

 l Paper Texture Tab on page 131

Tip Tab

The Tip tab allows you to configure the shape, size, hardness and spacing of your eraser tip.
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Eraser Type

Allows you to select between one of the follow ing eraser types:

 l Solid Vector: Simply cuts out the eraser stroke's shape from the vector artwork. 

A solid vector eraser always completely erase the artworks leaving hard seams. 

 l Textured  Eraser: Allows to configure the eraser w ith the same options as w ith 

a textured brush. A textured eraser w ill decrease the opacity of bitmap textures 

in textured brush strokes if it doesn't completely erase it. If it completely erases 

a brush stroke, it w ill cut out the erased part from the vector artwork.

 l Textured, Preserve Vector: Like a Textured Eraser, except that it w ill not cut 

out from the vector shapes, even if it fully erases pixels in a textured brush 

stroke's texture.

NOTE 

Textured erasers only work as expected on textured brush strokes. Using a 

Textured eraser on a solid vector brush stroke or on a pencil l ine w ill only cut the 

eraser stroke's shape out of it. If you use a Textured, Preserve Vector type eraser 

on a solid vector shape or on a pencil l ine, the eraser w ill not erase anything.
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NOTE 

This option is not available when working on a bitmap layer. W ith bitmap layers, 

erasers are always textured, and textured eraser options are always available.

Eraser Tip Library

This is where you select the shape of the eraser tip. By default, it is round. Note that 

some tips are designed to have semitransparent areas, even when the maximum eraser 

opacity is set to 100%.

To create a custom eraser tip, you must prepare the file ahead of time, either in 

Harmony or in a third-party software, such as Adobe Photoshop. Colour is not 

supported and transparency is not supported in the traditional sense. Black appears as 

100% opaque, white appears as 100% transparent and all the shades of grey in 

between appear as varying degrees of semitransparency. A range of file formats are 

supported—.jpeg, .png, .tif, .psd, .tga to name a few. Alpha channels are disregarded 

on import. It is recommended that your file be between 100 x 100 pixels and 400 x 400 

pixels. 

You can also import eraser tips that you exported from Harmony, so you can share 

them with colleagues.

Minimum and 

Maximum Size

The minimum and maximum sizes of your drawing tool produce the thick and thin 

effect on your stroke. This works w ith the pressure sensitivity of a pen tablet.

 l Maximum Size: Defines the maximum  w idth of the stroke.

 l Minimum Size: Defines the minimum width of the stroke in relation to and as a 

percentage of the maximum size.

You can control the size properties by clicking on the arrow button on right and the 

dialog box w ill appear as shown below.
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 l Pressure: Allows you to apply more pressure and increases the size of the 

brush. You can check the box to invert this behaviour.

 l Tilt: Allows you to tilt the pen closer to tablet for a bigger stroke. You can check 

the box to invert this behaviour.

 l Speed: Allows you to reduce the size of the stroke by drawing at a fast speed.  

You can check the box to invert this behaviour.

 l Speed Sensitivity: A slider is used to control how fast must the stroke be 

drawn to reach the minimum value.

 l Taper: Allows you to reduce the value of a property at the start or the end of 

each stroke. The value can be expressed using two options: Distance and 

Percentage. Distance is selected by default. For example: A taper of 200 w ill 

be the same length as the w idth (diameter) of a stroke that has its size set at 

200.

You can enable Start and End Tapering option individually.

 l Start Taper: W hen distance is selected as a Taper value, the effect of start 

taper can be visualized as the stroke is drawn. 

 l End Taper: W hen distance or percentage is selected as a Taper value,  the 

effect of end taper can be visualized once the stroke is complete and vectorized 

as the length is unknown until the stroke is complete.

 l Fade Distance: Allows you to fade the value of property over a given distance. 

It uses the same units as the size and is applied as the stroke is drawn.
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 l Size Proportional to Camera: If you check this option, the size of the  w ill be 

adjusted to the position of the camera on the z-axis. This means that if the 

camera is zoomed in on the scene, the  w ill be proportionally smaller so that it 

appears the same size in the rendered image. Likewise, if the camera is zoomed 

out, the  w ill be proportionally bigger.

NOTE 

Setting the Minimum Size value to 100% eliminates the possibility of creating 

w idth variation on your stroke. In other words, you would be forcing a uniform line 

w idth using the Maximum Size value.

Proportional to Camera

If you check this option, the size of the eraser w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

eraser w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the eraser w ill be proportionally bigger. 

Roundness and Angle

The Roundness and Angle parameters allow you to change the shape and orientation 

of the  tip.

 l Roundness: The vertical scaling to apply to the tip. Reducing this setting 

squashes the tip vertically, allow ing you to turn round or square tips into flat 

tips. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the tip is rotated, the squashing w ill 

stil l be done relative to the tip's original orientation.

Pen Tilt Sensitivity

If your pen and tablet support tilt sensitivity, this option allows you to set whether your 

eraser takes your pen's tilt angle in account, and how much. 

W hen your pen is fully tilted, your eraser tip w ill be stretched by the percentage you 

set in this parameter, in the angle in which you tilt it. For example, if you set the Pen Tilt 

Sensitivity to 50%, and you tilt your pen all the way up or down, your eraser tip w ill be 

stretched vertically by 50%. W ith the same setting, if you tilt your pen all the way left 

or right, your eraser tip w ill be stretched horizontally by 50%.
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Use Pen Rotation

If enabled, and if your pen and tablet support tip rotation, your eraser tip w ill rotate 

w ith the angle of your pen tip. 

Hardness

The Hardness and Spacing parameters allow you to change the softness and spacing 

of the marks made by the eraser tip. You can preview the hardness and spacing at the 

top of the Eraser Properties w indow, stroke preview area.

The hardness value corresponds to the softness of the eraser tip's edges. The lower 

the value, the softer the tip edge. The higher the value, the sharper the tip edge. Be 

aware that some eraser tips are not 100% opaque, so they w ill always appear 

somewhat soft, even at 100% hardness.

Spacing

Defines the amount of space between each stamp of the eraser. A value of 100% sets 

the stamp marks edge to edge, if there is no white space around the shape. The larger 

the value, the greater the space between marks. A really large value can make the 

eraser stroke appear as a string of individual marks. Conversely, a small spacing value 

w ill give the appearance of a fluid brush stroke. 

Spacing is only evident when making a continuous stroke. 
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Randomness
The Randomness parameters let you create a varied bitmap eraser stroke. Refining 

these options can give your stroke a lovely, non-mechanical look.

Random Size

You can create variation between the thick and thin of your eraser stroke just by setting 

the Maximum and Minimum Size values. If you add randomness to the mix, pressure 

sensitivity from your drawing tablet w ill stil l be applied. Light pressure w ill create 

random values around the minimum, while heavy pressure w ill create random values 

closer to the maximum. The larger the percentage, the larger the range of random 

variation.  

NOTE 

Setting the Minimum Size to 100% eliminates the possibility of creating w idth 

variation on your stroke, whether you are applying randomness or not. Therefore, 

you would be forcing a uniform line w idth using the Maximum Size value.

Random Angle

Sets the range for random rotation around the set Angle value. For example, if the 

Angle is set to 45° and the Random Angle set to 10°, the software w ill choose values 

between 40°–50° (plus or minus 5 degrees, equaling a total of 10 degrees).
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Random Spacing

Sets the range for random spacing around the set Spacing value. For example, if the 

Spacing is set to 50% and the Random Spacing is set to 10%, then Harmony w ill 

choose values between 45%–55% (plus or minus 5 percent, equaling a total of 10 

percent).

Smoothing Tab   

The Smoothing tab contains options to configure how Harmony should automatically smooth your eraser 

strokes as you paint. 
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NOTE 

The Smoothing tab is only available when working on a vector layer, as bitmap layers do not 

support smoothing.

Property Description

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on your eraser stroke's 

direction, curves and corners. A higher setting w ill prevent your line from being 

shaky, but is liable to reduce drawing precision and turn sharp angles into curves.

Contour Smoothing

  Defines the amount of smoothing Harmony should perform on outer contour of the 

eraser stroke. A higher setting w ill round sharp corners and reduce the amount of 

control points for the resulting vector shape. 

Transparency Tab

The Transparency tab allows you to decide if your eraser has antialiasing as well as to set its flow and opacity 

settings. 
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NOTE 

The Transparency tab's options are only available on vector layers if the Eraser Type option of the 

Tip tab is set to Textured Vector or Textured, Preserve Vector.. On bitmap layers, those options 

are always available.

Property Description

Antialiasing

Enabled by default. This option causes the contours of the eraser strokes to 

blend w ith the surrounding colours, to create an il lusion of smoothness 

otherwise not possible due to the picture resolution.

If antialiasing is disabled, the eraser w ill either fully erase pixels or leave them 

intact.

NOTE 

W hen disabled, all other options in the Transparency tab are disabled.

Maximum and Minimum Flow

The Maximum and Minimum Flow parameters let you set the range for the rate 

at which your eraser's effect flows. The greater the flow, the more consistent the 

effect is. If the flow is light,  then the effect may look spotty. This feature works 

w ith the pressure sensitivity of a pen tablet.

 l Maximum Flow: Sets the maximum rate at which colour and texture are 

applied as you create a fluid stroke. 

 l Minimum Flow: Sets the minimum rate at which colour and texture are 

applied as you create a fluid stroke. It is defined as a percentage of the 

Maximum Flow value. If the Minimum Flow value is set to 100%, then 

tablet pressure sensitivity w ill no longer be applicable. The flow will be 

set to the constant rate of the Maximum Flow value.

Maximum Opacity and 

Minimum Opacity

The Maximum and Minimum Opacity parameters are where you set the opacity 

range for a eraser mark. This works w ith the pressure sensitivity of a pen tablet.

 l Maximum Opacity: Sets the  transparency limit of the eraser mark when 

the pressure is heavy. 

125

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

Property Description

 l Minimum Opacity: Sets the transparency limit of the eraser mark when 

the pressure is very light. It is defined as a percentage of the Maximum 

Opacity value. If the Minimum Opacity value is set to 100%, then tablet 

pressure sensitivity w ill no longer be applicable. The opacity w ill be set 

to the constant rate of the Maximum Opacity value.

Randomness
Th Randomness parameter lets you set the range for the randomness of the flow 

and opacity. This works w ith the pressure sensitivity of a pen tablet.

Randomness Flow

You can create variation in the flow of your eraser stroke just by setting the 

Maximum and Minimum Flow values. If you add randomness to the mix, pressure 

sensitivity from your drawing tablet w ill stil l be applied. Light pressure w ill 

create random values around the minimum, while heavy pressure w ill create 

random values closer to the maximum. The larger the percentage, the larger the 

range of random variation. 

NOTE 

Setting the Minimum Flow value to 100% eliminates the possibility of 

creating flow variation on your stroke, whether you are applying 

randomness or not. That is, you would be forcing a uniform flow using the 

Maximum Flow value.
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Random Opacity

You can create variation in the opacity of your eraser stroke just by setting the 

Maximum and Minimum Opacity values. If you add randomness to the mix, 

pressure sensitivity from your drawing tablet w ill stil l be applied. Light pressure 

w ill create random values around the minimum, while heavy pressure w ill create 

random values closer to the maximum. The larger the percentage, the larger the 

range of random variation.

NOTE 

Setting the Minimum Opacity value to 100% eliminates the possibility of 

creating opacity variation on your stroke, whether you are applying 

randomness or not. That is, you would be forcing a uniform opacity using 

the Maximum Opacity value.

Dual Tip Tab

The Dual Tip tab lets you set the parameters for creating a dual tip eraser. The primary bitmap eraser tip and 

the dual tip always work together. You can set the parameters for the primary tip in the Tip tab and those for 

the dual tip in the Dual Tip tab. The Blend mode you select determines how the tips are combined. 

By default, the Blend Mode is set to Multiply and the Random Angle to 360°.
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NOTE 

To use a Dual Tip, you must enable option by checking the checkbox inside the Dual Tip tab. 

Additionally, if you are working on a vector layer, the Eraser Type option of the Tip tab must be set 

to Textured Vector or Textured, Preserve Vector.

Tool Name Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your eraser uses a 

dual tip. If this checkbox is unchecked, the options in the Dual Tip tab w ill be 

disabled. 

Blend Mode The Blend modes let you decide how the primary tip and the dual tip are combined.

Multiply

This is the default blend mode. W hen the two eraser tips are combined in this mode, 

they essentially cut each other out in overlapping areas, where one or both tips have 

an area of 100% transparency. The less opaque the eraser tips are, the lighter their 
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combination. 

Colour Dodge

In this mode, the primary tip cuts out the shape of the dual tip. W here the tip shapes 

overlap, w ithin the boundaries of the primary shape, the colour and opacity appear 

darker.
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Combine
This mode treats the two tips as two different and separate erasers that have the 

same colour and follow the same path.
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Tool Name Description

Paper Texture Tab

The Paper Texture tab lets you configure a paper- like texture for your eraser. You can also add textures by 

importing image files, or import paper textures that were previously exported from Harmony.
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NOTE 

To use a Paper Texture, you must enable option by checking the checkbox inside the Paper 

Texture tab. Additionally, if you are working on a vector layer, the Eraser Type option of the Tip 

tab must be set to Textured Vector or Textured, Preserve Vector.

Property Description

Enable/Disable

The checkbox inside the tab allows you to decide whether or not your eraser uses a 

paper texture. If this checkbox is unchecked, the options in the Paper Texture tab w ill 

be disabled. 

Texture Scale Increase or decreases the size of the paper texture.

Additive

This option layers the texture on top of itself as you scribble overlapping lines in one 

continuous stroke.  If this option is turned off, areas of overlapping lines from a single, 

continuous stroke w ill appear the same, in terms of darkness and texture, as non-
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Property Description

overlapping areas.

Aligned

This option defines the way separate, overlapping strokes behave. If this option is 

enabled, the paper texture's position does not change w ith each sweep of the eraser. 

If this option is disabled, each sweep of the eraser produces a different texture 

position. The texture orientation always stays the same.
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Ink Tool Properties

W hen you select the Ink tool, its properties and options appear in the Tool Properties view.

Icon Tool Name Tool

Lasso

Sets the selection mode to Lasso, which allows 

you to select multiple items by drawing a lasso 

around them.

TIP 

W hen this option is enabled, you can 

press and hold the Alt key to temporarily 

use Marquee mode.

Marquee

Sets the selection mode to Marquee, which allows 

you to select multiple items by drawing a rectangle 

around them. 

TIP 

W hen this option is enabled, you can 

press and hold the Alt key to temporarily 

use Lasso mode.

Show Inkable Lines

Highlights all pencil l ines (no brush strokes) on the 

selected layer. Pencil l ine segments that are 

already inked w ith the selected swatch colour from 

the colour palette are also not highlighted.

Be Smart on Connecting Lines

As you hover and move the cursor across 

intersecting pencil l ines, the path that you create 

w ill be highlighted. W hen you click on your mouse 

or stylus the highlighted segments are inked.  W ith 

this option disabled, all the intersecting segments 

that your cursor comes near w ill be highlighted 

and become part of the selection, even if they were 

not situated in the direction of the chosen path.
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NOTE 

This option only works if the Ink tool is in 

Hover mode.

Select Mode

Use this mode instead of the Hover Mode. In the 

Hover Mode, any potentially inkable pencil l ine w ill 

have its central vector line highlighted as the Ink 

tool’s cursor hovers over it. Use Ctrl 

(W indows/Linux) or ⌘  (macOS) to toggle between 

the two modes.

Select Newly Painted, Repainted, 

and Unpainted Contours/Lines

In the Paint   tool properties, this option  keeps a 

selection highlighted around the latest painted 

zone after using the Paint, Repaint, Unpaint, or 

Paint Unpainted tool.

Raise

As you ink the pencil l ine, the segment w ill be 

moved on top of the other intersecting strokes. 

Disable this option for the line to be sent behind. 

Hold down the Alt key to perform the opposite 

operation as you ink.

Mitre

As you hover over two perpendicular or nearly 

perpendicular segments, a highlighted path w ith a 

corner is created. Clicking on these highlighted 

segments inks both segments and makes them 

appear as a single stroke w ith a corner or bend. 

Options include: As Is, Round, Miter, and Bevel.

Tip Style
Lets you customize the edge of the Ink tool. 

Options include: Round, Flat, and Bevel.
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Line Tool Properties

The Line tool allows you to quickly draw a line segment by dragging the mouse from its starting point to its 

end point.

How to access the Line tool properties

 1. In the Tools toolbar, select the Line  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil l ines. Hence, its tool properties are similar to the ones of the 

Pencil tool and it can be used w ith pencil presets.
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Tool Name Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.

Pencil Properties 

Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

W hile the Tool Properties view only gives you access to a few of the pencil properties, 

a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 

access to all the available options for your pencil 's shape and texture. For more 

information on the Pencil Properties dialog, see the Pencil Properties Dialog section 

below.

Size Defines the w idth of the pencil l ine used to draw the line.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 

can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can choose 

between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.

137

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 

also lets you create and save your own. It is a good idea to create and 

save pencils w ith precise sizes and parameters when you draw for 

efficiency and consistency.

A thickness stencil saves the thickness information across the length of 

the line.  W hen drawing w ith a thickness stencil, the pressure sensitivity 

of the tablet is discarded. A thickness stencil can be used while drawing, 

or applied afterwards.

You also have the possibility to apply different textures to your lines by 

either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 

those that others have created. This is a good way for you and project 

collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the follow ing options:

 l New Brush Preset: Creates a new preset based on the current 

tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 

preset.

 l Import Brushes: Allows you to import brush presets exported 

from Harmony.

 l Export Brushes: Allows you to export your brush presets into an

 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 

w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Draw Behind

W hen enabled, your brush strokes w ill appear behind the existing artwork. 

NOTE 

Your brush stroke w ill temporarily appear over your artwork as you 

draw it, until you release the mouse cursor or tablet pen. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up menu in 

which you can toggle different snapping modes. You can also click on this 

button to toggle it off, which w ill disable all snapping modes, and click on it 

again and toggle it on to re-enable the snapping modes which were 

previously enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hen enabled, while you're drawing, the mouse 

cursor w ill automatically snap to the nearby contours of existing 

artwork, allow ing you to draw shapes that connect w ith other parts 

of your drawing. 
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NOTE 

If you draw a line w ith the Line tool and make its tip snap to a 

contour or another control point in your artwork, they w ill be 

locked together. You can then manipulate both 

simultaneously using the  Contour Editor  tool. You can 

also separate two drawing strokes that have been snapped 

together by selecting one of them with the  Select  tool 

and moving it away.

 l Snap to Alignment Guides: W hile drawing, the drawing tool w ill 

snap against nearby alignment guides.

 l Snap and Align: W hen enabled, while you're drawing, the mouse 

cursor w ill automatically align w ith the edges of strokes and shapes 

in your artwork, allow ing you to draw shapes that align w ith parts of 

your drawing.

 l W hen enabled, while you're drawing, the mouse cursor w ill snap 

against the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid from the 

top menu or press Ctrl + '.

Automatically 

Create Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art layer.
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Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as a 

separate drawing object, which can be edited independently from other 

parts of the artwork. W hen enabled, the Auto-Flatten option automatically 

merges strokes into existing artwork. 

NOTE 

Using the Select tool, you can use select and remove a segment of 

flattened pencil l ines. Overlapping pencil l ines drawn with the Auto-

Flatten mode are essentially cut into segments by the overlap and can 

be treated as individual lines.

Auto-Close Gap

W hen enabled, small gaps between the pencil l ines you draw will be closed 

by an invisible stroke to make sure your shapes are closed and that they can 

be fil led w ith the Paint tool.

W hen drawing contours w ith pencil l ines, the centreline is used to 

determine whether or not the contour is closed, but the visible tips of the 

pencil l ine w ill extend a bit beyond the tips of its centreline, making it 

possible to have shapes that appear closed, but are not really. This can 

prevent the shape from being fil led w ith the Paint tool. Enabling this option 

when drawing w ith the Pencil or Line tool w ill prevent you from leaving 

invisible gaps in your contours.

 

Line Building Mode

The Line Building mode is very useful when drawing long lines and curves 

in small increments w ith pencil l ines or the Line tool. As the pencil l ines are 

central vector lines, it may be difficult to align the line tips perfectly to 

create a uniform stroke and close all gaps.
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In this mode, you can draw lines in small increments and the tips are merge 

into one single stroke.

NOTE 

This mode only works w ith pencil l ines or the line  tool.

Use Stored Colour 

Gradient

The Use Stored Colour Gradient  option can be used when painting w ith a 

gradient colour to always position the gradient in the same way it was 

stored, making it consistent across brush strokes. You can store a gradient 

by selecting a zone painted w ith a gradient w ith the Select tool, then 

clicking on Store Colour Gradient  in the Tool Properties view.

Straight Line Mode

Draws a straight line. 

In this mode, you can draw curved lines w ith the follow ing method:

 1. Draw the line by clicking and dragging from the start point to the 

end point of the line, but don’t release the mouse button or pen yet.

 2. W hile holding the mouse button or pen down, press and hold the 

Ctrl (W indows/Linux) or ⌘  (macOS) and move the mouse or pen to 

define the line’s curve.

 3. Once the line’s curve looks right, release the mouse button or pen.
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Curve Line Mode

This mode allows you to draws a simple curved (quadratic Bezier) line in 

two clicks:

 1. Draw the line by clicking and dragging from the start point to the 

end point of the line.

 2. Move the mouse or pen to define the curve of the line and click.

S Curve Line Mode

Draws an S-shaped (cubic Bezier) line. This mode allows you to draw lines 

w ith finely tuned or even S-shaped curves w ith three clicks:

 1. Draw the line by clicking and dragging from the start point to the 

end point of the line.

 2. Move the mouse or pen to define the Bezier position of the 

beginning of the line and click.

 3. Move the mouse or pen to define the Bezier position of the end of 

the line and click.
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Icon Tool Name Description

Pencil Properties Dialog

Since the Line tool draws pencil l ines, you can use the Pencil Properties dialog to customize the type of lines it 

draws. To open the Pencil Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil 's size, its smoothing parameters as well as the 

shape of its tips and corners. 

Property Description

Maximum Size Defines the maximum size of the pencil l ine. If the tool is used w ith a pressure 
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sensitive pen tablet, the w idth of the stroke w ill vary between its maximum size and 

minimum size depending on the amount of pressure used. If used w ith a mouse, the 

w idth of the stroke w ill always be its maximum size. 

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you 

do not have pressure sensitivity from a pen table, the minimum size value w ill be 

ignored. 

Proportional to Camera

If you check this option, the size of the pencil w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

pencil w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the pencil w ill be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

pencil stroke. A higher setting w ill prevent your line from being shaky and w ill reduce 

the amount of control points it has, making it easier to tweak, but is liable to reduce 

drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the pencil stroke. 

A pencil l ine is defined by its centreline and its variations in thickness, rather than its 

apparent shape. W hen drawing a pencil l ine w ith a mouse, its thickness is uniform. 

Therefore, its outer contour does not have any control point, except at its extremities, 

and no smoothing is required for its contour. 

However, when drawing a pencil l ine w ith a pressure sensitive tablet, its contour w ill 

have control points and Bezier curves to define the line's variations in thickness, and 

thus smoothing must be performed on its contour. An increased contour smoothing 

w ill reduce the amount of control points on the line's thickness and smoothen its 

curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 

You can choose between Round or Flat style.
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 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can 

choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 

pencil texture palette to use w ith the Pencil tool. You can also add, remove or rename textures, save the 

current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 

Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 

Colour view—see Colour View  on page 239. 

Icon Property Description

Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 
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texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 

the current pencil texture palette. The pencil texture's effect on your 

pencil l ine w ill be based on the image's transparency channel, and w ill 

follow your pencil l ines on its horizontal axis. This option is also 

available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 

This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 

texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 

allows you to select one to use w ith the Pencil tool.

  Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for 

reference. To select a different pencil texture palette, you must select it 

in the Colour view—see Colour View  on page 239.
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Paint Tool Properties

The Paint tool allows you to fil l closed areas of your drawing w ith the selected colour. 

How to access the Paint tool properties

 1. In the Tools toolbar, select the Paint , Paint Unpainted , Repaint  or Unpaint  tool.

The tool's properties are displayed in the Tool Properties view.

Paint Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing an 

irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by drawing a 

rectangle around them. This is faster, as you only need to drag 

your mouse from one corner of the rectangle to its opposite corner, 

but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 

selection mode.
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Paint Mode

The Paint tool has four different modes:

 l Paint:  Paints or repaints selected zones, whether or not they 

are already fil led.

 l Paint Unpainted:  Only paints empty zones, and does not 

repaint zones that are already fil led w ith colour. 

 l Repaint:   Only paints zones that are already fil led w ith colour, 

and does not fil l empty zones.

 l Unpaint: Removes colour from the selected zone, replacing it 

w ith transparency.

Paint and Remove 

Textures

The Paint and Remove Texture  option is used when you vectorized images 

as greyscale texture style. An image vectorized as texture is a mix of 

bitmap fil l ing encapsulated in a vector-based frame. Painting a textured 

zones w ith the Paint tool w ill change the tint of the textured lines. 

Painting the textured zones using the Paint and Remove Texture option 

transforms the bitmap fil l ing into a 100% vector based zone and fil ls it 

w ith a solid colour.

Apply to Visible 

Drawing Layers

This option allows you to select which layers the tool should affect. It can 

be toggled on or off. W hen toggled on, it has two different modes. You 

can select a mode by clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on the 

currently selected layers. If several layers are selected, the tool 

w ill work on all these layers simultaneously. 

 l On W hen this button is toggled on, the tool w ill work on all the 

visible layers.

 l  Apply to Visible Drawing Layers: The tool w ill work on all the 

visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 

layer is synced w ith another layer, the tool w ill work on both the 

current layer and its synced layer. 
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Icon Property Description

NOTE 

This option only works in the Camera view. 

Apply to All Frames

This option allows you to determine which drawings in the current layer 

the tool should affect. It can be toggled on or off. W hen toggled on, it has 

two different modes. You can select a mode by clicking and holding on the 

button.

 l Off: W hen this button is toggled off, the tool only works on the 

drawing in the current frame.

 l Apply to All Frames: The tool w ill work on every exposed 

drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool w ill work on every 

drawing displayed in the Onion Skin. Onion Skin must be enabled 

for this option to work. 

Respect Protected 

Colour

The Respect Protected Colour option is enabled by default. In your Colour 

view, you can protect some colour swatches to avoid repainting or 

unpainting the zones linked to that swatch. 

If you disable this option the Paint tool w ill not follow the protect colour 

rule and w ill repaint or unpaint the protected colours on your drawings 

until you enable the option again.

Use Stored Colour 

Gradient

W hen you paint a zone w ith a gradient or textured colour swatch, the 

gradient or texture’s position is set relative to the size of the zone you are 

painting. If you want the Paint tool to use a particular size and position, 

you must first store your desired position and size using the Select  tool 

and then enable the Use Stored Colour Gradient   option in the Paint tool 

properties.
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Select Newly 

Painted, Repainted, 

and Unpainted 

Contours/Lines

In the Paint   tool properties, this option  keeps a selection highlighted 

around the latest painted zone after using the Paint, Repaint, Unpaint, or 

Paint Unpainted tool.

Close Gap

By default, if you attempt to fil l a shape that has a small gap in its contour, 

the Paint tool w ill not be able to fil l the shape. This option allows you to 

make the Paint tool automatically add a stroke to close the shape when it 

detects a small gap between two strokes in the shape. 

The Close Gap setting can be set to a value between 0 and 10. This 

determines the maximum size of a gap to close, in pixels. You can also use 

one of the follow ing presets:

 l No Close Gap: Sets the Close Gap setting to 0, disabling the 

feature. 

 l Close Small Gap: Sets the Close Gap setting to 2, making the 

Paint tool close gaps that are barely visible. 

 l Close Medium Gap: Sets the Close Gap setting to 4, making 

the Paint tool close gaps that are somewhat visible. 

 l Close Large Gap: Sets the Close Gap setting to 8, making the 

Paint tool close gaps that are easy to notice. 
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Bitmap Options

Since bitmap drawings are made of pixels instead of shapes, and that the outlines of shapes in bitmap 

drawings are often feathered, it can be complicated to figure out exactly the area the Paint tool must fil l when 

trying to fil l a zone in a bitmap drawing. For example, if the Paint tool only replaces pixels w ith the exact same 

colour as the one you click on w ith the selected colour, it w ill leave a small gap near the outlines of the shape. 

The follow ing settings determine how the Paint tool figures out the area it must fil l. W hen any of these 

settings are increased, the Paint tool's tolerance for colour or alpha differences increases and it w ill a bigger 

area that it otherwise would. 

Icon Property Description

Source

Allows you to select which art layer to use in order to determine the 

fil lable zone. By default, this is set to Current Art , which means the 

layer you are fil l ing w ill be used to determine the fil lable zone. 

However, if you want to keep your colour art on the Colour Art layer 

and the line art on the Line Art layer, you can set the Source to Line Art 

, and then use the Paint tool on the Colour Art layer. The Paint tool 

w ill use the artwork in the Line Art layer to determine the area to fil l 

w ith colour, but w ill stil l add this colour to the Colour Art layer.

This property has the follow ing options:

 l Current Art: Bases the zone to fil l on the current art layer.

 l Line Art: Bases the zone to fil l on the Line Art layer, 

regardless of which layer you are painting on.

 l Colour Art: Bases the zone to fil l on the Colour Art layer, 

regardless of which layer you are painting on.

-- Alpha

The alpha threshold that separates opaque and transparent zones. 

W hen fil l ing a "transparent" zone, the paint tool w ill apply the colour 

under semi-transparent pixels, making them opaque. Then fil l ing an 

"opaque" zone, the paint tool w ill replace the colour of semi-

transparent pixels w ithout affecting their transparency. 

If you want to repaint lineart or shapes that have no outlines, you can 

do so by decreasing this setting completely. This w ill make it fil l any 
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pixel that isn't 100% transparent, so it w ill paint your outlines 

completely. However, if you're using this method to repaint outlines, 

they must not be fil led yet for this method to work. 

If you want to paint transparent zones that have dirt or semi-

transparent spots, you can increase this setting to make the Paint tool 

paint behind them instead of around them. 

NOTE 

Raising this setting too high may cause the paint tool to ignore 

outlines that are not 100% opaque, which can cause it to think 

the shape is not closed. Hence, it might fail to find a zone to fil l 

and not do anything.

-- Colour Tolerance

The amount of tolerance the paint tool has for changes in colour when 

fil l ing an area. Raising this setting w ill allow the paint tool to fil l over 

areas that have some variations in colour, but may cause it to fil l 

beyond the areas you meant to paint.

-- Maximum Overlap

The maximum amount of pixels beyond the fil lable zone that the Paint 

tool can fil l.

W hen this setting is set to any value above zero, the paint tool w ill fil l 

the zone until it finds a pixel that is a different colour, value or 

transparency as the one you clicked on. Then, it w ill start fil l ing pixels 

beyond that point, up until it fil led the amount of pixels in the 

Maximum Overlap setting. 

If it lands outside of a fil lable zone before it reached the maximum 

overlap, it w ill stop fil l ing at that point. However, if it lands into 

another fil lable zone before reaching its maximum overlap, it w ill fil l 

that zone as well. Therefore, if you're fil l ing shapes inside other 

shapes, you have to set this setting to the approximate w idth of your 

outlines. Setting it higher w ill make the colour spill beyond the zone 

you clicked on and fil l the zone outside of it, and setting it lower is 

liable to leave a small gap between the fil l and the outlines.
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NOTE 

W hen you fil l a zone w ith overlap, Harmony tries to detect and 

preserve the outlines of your shape. This is easy to do when 

fil l ing a transparent shape, or when repainting a shape made of 

solid outlines and a solid fil l. However, if you are trying to 

repaint an already painted zone, it may fail to detect your 

outlines and may repaint over them if the colour of your 

outlines or inside the shape isn't consistent. Therefore, it is 

highly recommended to avoid repainting painted zones as much 

as possible when working w ith bitmap layers. 

Antialiasing

W hen enabled, the outlines of the fil l w ill be smoothed so that they do 

not look pixelated. 

NOTE 

The effect of this setting w ill not be visible if you fil l all the way 

to the outlines, as the Paint tool w ill preserve the antialiasing of 

existing outlines when fil l ing up to them. 
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 Pencil Tool Properties

The Pencil tool allows you to draw simple contour lines that are defined by their centerline and their thickness. 

W hen you select the Pencil tool, the Tool Properties view displays the different Pencil modes that control how 

the pencil l ine is drawn.

How to access the Pencil tool properties

 1. In the Tools toolbar, select the Pencil  tool. 

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

The follow ing properties affect the pencil 's size, smoothing, shape and other properties for the drawing style 

of your pencil. Those properties can be saved into pencil presets for later use. 

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.
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Property Description

Pencil Properties 

Dialog

The arrow button right of the preview area opens the Pencil Properties dialog. 

W hile the Tool Properties view only gives you access to a few of the pencil properties, 

a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 

access to all the available options for your pencil 's shape and texture. For more 

information on the Pencil Properties dialog, see the Pencil Properties Dialog section 

below.

Maximum Size

Defines the maximum width of the pencil l ine.

If the tool is used w ith a pressure sensitive pen tablet, the w idth of the stroke w ill vary 

between its maximum size and minimum size depending on the amount of pressure 

used. If used w ith a mouse, the w idth of the stroke w ill always be its maximum size. 

Centerline Smoothing
Defines the number of control points added to the centre line. The fewer the control 

points the smoother (but less faithful) the line.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 

can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can choose 

between Round, Mitre and Bevel style.

Pencil Presets

These options allow you to select, create and manage pencil presets.

156



Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 

also lets you create and save your own. It is a good idea to create and 

save pencils w ith precise sizes and parameters when you draw for 

efficiency and consistency.

A thickness stencil saves the thickness information across the length of 

the line.  W hen drawing w ith a thickness stencil, the pressure sensitivity 

of the tablet is discarded. A thickness stencil can be used while drawing, 

or applied afterwards.

You also have the possibility to apply different textures to your lines by 

either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 

those that others have created. This is a good way for you and project 

collaborators to keep a consistent look for the project.

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the follow ing options:

 l New Brush Preset: Creates a new preset based on the current 

tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 

preset.

 l Import Brushes: Allows you to import brush presets exported 

from Harmony.

 l Export Brushes: Allows you to export your brush presets into an

 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 

w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork.
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Draw Behind

W hen enabled, your brush strokes w ill appear behind the existing 

artwork. 

NOTE 

Your brush stroke w ill temporarily appear over your artwork as 

you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

W hen enabled, drawing a closed shape w ill automatically fil l it w ith the 

currently selected Paint colour. 

TIP 

By default the pencil l ine and its fil l w ill be the same colour. To 

select different colours for the line and its fil l, do the follow ing:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 

the colour list, select the desired colour swatch for your 

outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 

colour list, select the desired colour swatch for the fil l. 

Trim Extra Lines

W hen enabled, drawing a closed shape w ill automatically remove the 

outstanding  lines. 
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Align Handles After 

Trim

W hen the Trim Extra Lines option is enabled, enable this option to make 

the point where the beginning and end of the stroke meet into a smooth 

curve rather than a hard corner. 

Automatically Create 

Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art 

layer.

Auto Flatten

By default, when drawing on a vector layer, each new stroke is created 

as a separate drawing object, which can be edited independently from 

other parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 

NOTE 

Using the Select tool, you can select and remove a segment of 

flattened pencil l ines. Overlapping pencil l ines drawn with the 

Auto-Flatten mode are essentially cut into segments by the 

overlap and can be treated as individual lines.                         

Auto-Close Gap
W hen enabled, small gaps between the pencil l ines you draw will be 

closed by an invisible stroke to make sure your shapes are closed and 
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that they can be fil led w ith the Paint tool.

W hen drawing contours w ith pencil l ines, the centreline is used to 

determine whether or not the contour is closed, but the visible tips of the 

pencil l ine w ill extend a bit beyond the tips of its centreline, making it 

possible to have shapes that appear closed, but are not really. This can 

prevent the shape from being fil led w ith the Paint tool. Enabling this 

option when drawing w ith the Pencil or Line tool w ill prevent you from 

leaving invisible gaps in your contours.

 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping mode:

 l Snap to Alignment Guides: W hile drawing, the drawing tool 

w ill snap against nearby alignment guides.

Line Building Mode

The Line Building mode is very useful when drawing long lines and 

curves in small increments w ith pencil l ines or the Line tool. As the 

pencil l ines are central vector lines, it may be difficult to align the line 

tips perfectly to create a uniform stroke and close all gaps.

In this mode, you can draw lines in small increments and the tips are 

merge into one single stroke.
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NOTE 

This mode only works w ith pencil l ines or the line  tool.

Auto Adjust Thickness

The Auto Adjust Thickness  tool is useful when you want to render a 

portion of a line thicker. W hen tracing a drawing on paper, you w ill often 

go back to a section of a curve to make it thicker to add dynamism to the 

line. Using the Auto Adjust Thickness tool, you can draw highlight 

strokes over the section to make thicker. Once you release the pen or 

mouse, the line becomes thicker follow ing the shape and curve of the 

original stroke. This way is much faster and smoother than using the 

Pencil Editor tool. You do not have to add extra points and adjust the 

position and Bezier handles.

The default overlay colour is light yellow. If this colour is difficult to see 

because of the background or drawing colour, you can adjust the colour.

Line Pushing Mode

The Line Pushing Mode  option lets you draw highlight strokes over 

existing pencil l ines. You can reshape the curves. Depending how you 

draw the pushing stroke over your line, the highlighted section w ill be 

reshaped in one direction or the other.

The default overlay colour is light yellow. If this colour is difficult to see 

because of the background or drawing colour, you can adjust the colour.

  Colour
You can change the colour of the temporary strokes that appear in the 

drawing space when using the Line Pushing Mode or the Auto Adjust 
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Thickness option by clicking on the Colour swatch and selecting a new 

colour in the Colour Picker dialog. 

Pencil Properties Dialog

Pencils have extra parameters which are not accessible from the Tool Properties view. To open the Pencil 

Properties dialog, click on the arrow button right of the stroke display area. 

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil 's size, its smoothing parameters as well as the 

shape of its tips and corners. 

Property Description

Maximum Size

Defines the maximum size of the pencil l ine. If the tool is used w ith a pressure 

sensitive pen tablet, the w idth of the stroke w ill vary between its maximum size and 

minimum size depending on the amount of pressure used. If used w ith a mouse, the 

w idth of the stroke w ill always be its maximum size. 
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Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you 

do not have pressure sensitivity from a pen table, the minimum size value w ill be 

ignored. 

Proportional to Camera

If you check this option, the size of the pencil w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

pencil w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the pencil w ill be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

pencil stroke. A higher setting w ill prevent your line from being shaky and w ill reduce 

the amount of control points it has, making it easier to tweak, but is liable to reduce 

drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the pencil stroke. 

A pencil l ine is defined by its centreline and its variations in thickness, rather than its 

apparent shape. W hen drawing a pencil l ine w ith a mouse, its thickness is uniform. 

Therefore, its outer contour does not have any control point, except at its extremities, 

and no smoothing is required for its contour. 

However, when drawing a pencil l ine w ith a pressure sensitive tablet, its contour w ill 

have control points and Bezier curves to define the line's variations in thickness, and 

thus smoothing must be performed on its contour. An increased contour smoothing 

w ill reduce the amount of control points on the line's thickness and smoothen its 

curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can 

choose between Round, Mitre and Bevel style.
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Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 

pencil texture palette to use w ith the Pencil tool. You can also add, remove or rename textures, save the 

current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 

Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 

Colour view—see Colour View  on page 239. 

Icon Property Description

Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 

texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 

the current pencil texture palette. The pencil texture's effect on your 

pencil l ine w ill be based on the image's transparency channel, and w ill 

follow your pencil l ines on its horizontal axis. This option is also 

available from the menu button.
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Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 

This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 

texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 

allows you to select one to use w ith the Pencil tool.

  Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for 

reference. To select a different pencil texture palette, you must select it 

in the Colour view—see Colour View  on page 239.
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Pencil Editor Tool Properties

W hen you select the Pencil Editor  tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing 

an irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by 

drawing a rectangle around them. This is faster, as you only 

need to drag your mouse from one corner of the rectangle to its 

opposite corner, but it may not be as precise as you want.
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TIP 

You can press and hold the Alt key to temporarily use the other 

selection mode.

Apply to Visible Drawing 

Layers

This option allows you to select which layers the tool should affect. It 

can be toggled on or off. W hen toggled on, it has two different modes. 

You can select a mode by clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on the 

currently selected layers. If several layers are selected, the tool 

w ill work on all these layers simultaneously. 

 l On W hen this button is toggled on, the tool w ill work on all the 

visible layers.

 l  Apply to Visible Drawing Layers: The tool w ill work on all 

the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently selected 

layer is synced w ith another layer, the tool w ill work on both 

the current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

  Maximum Size

Defines the maximum width of the pencil l ine. 

If the pencil l ine has a constant size, this w ill define the w idth of the 

pencil l ine all over. If the pencil l ine has a varying size, this w ill define 

the w idth of its larger areas. Areas that are in-between the maximum 

and minimum size w ill be resized proportionally.

  Minimum Size

Defines the minimum width of the pencil l ine. If the pencil l ine has a 

varying size, this w ill define the w idth of its smaller areas. Areas that 

are in-betwen the maximum and minimum size w ill be resized 

proportionally.

  Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first 

167

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

tip you drew. You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip 

you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the 

line curves abruptly. You could also define the Join style as the 

corner style. You can choose between Round, Mitre and Bevel 

style.

  Presets

Harmony provides a variety of pencil presets and thickness stencils 

and also lets you create and save your own. It is a good idea to create 

and save pencils w ith precise sizes and parameters when you draw for 

efficiency and consistency.

A thickness stencil saves the thickness information across the length 

of the line.  W hen drawing w ith a thickness stencil, the pressure 

sensitivity of the tablet is discarded. A thickness stencil can be used 

while drawing, or applied afterwards.

You also have the possibility to apply different textures to your lines by 

either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 

those that others have created. This is a good way for you and project 

collaborators to keep a consistent look for the project.

New Brush Allows to create a new preset from the selected pencil l ine.

Delete Brush Deletes the currently selected preset.

  Rename Brush Allows you to rename the currently selected preset.

 

Small Thumbnail, Large 

Thumbnail, and Stroke 

View

Allows you to display the presets as small square thumbnails, large 

square thumbnails or a list of stroke preview. 

Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 
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texture palette.

  New Texture Adds a new custom pencil texture to the list.

  Delete Texture Deletes a texture preset from the list.

  Rename Texture Renames the selected texture to keep the list organized.

  Presets
Harmony provides a variety of pencil texture presets and also lets you 

create and save your own.

  Pencil Texture Palette
Displays the colour palette assigned to hold the pencil textures. Use 

the Colour View menu to assign a new palette.

Smooth Selection

The Smooth operation lets you smooth out selected drawing strokes 

and remove extra points.

TIP 

You can also smooth the selection by selecting Selected  > 
Smooth from the top menu or by pressing Alt + Shift + S.             

Pump Pencil Pressure

The Pump Pencil Pressure  option is used to increase the line thickness 

of a selected area on a pencil l ine.

Deflate Pencil Pressure
The Deflate Pencil Pressure option is used to decrease the line 

thickness of a selected area on a pencil l ine.
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Merge Pencil Lines

Because pencil l ines are defined by their centre lines, two pencil l ines 

that brush against each other may not actually make a closed shape, 

even if they appear closed. If you select several pencil l ines that are 

close together, you can use this button to close the small gaps 

between these pencil l ines and make them into a single pencil l ine.

 

Reverse Pencil Thickness

The Reverse Pencil Thickness  option inverts the thick and thin section 

on a selected pencil l ine. This option w ill take the thickest size on the 

line and apply it to the thinnest, and it w ill apply the thinnest to the 

thickest.
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Perspective Tool Properties

The perspective tool allows you to deform artwork by creating a rectangular bounding box around it and 

allowing you to manipulate any of the four corners. The selected artwork w ill be deformed to fit the shape you 

make by simulating a perspective effect.

How to access the Perspective tool properties

 1. In the Tools toolbar, select the Perspective   tool.

The tool's properties are displayed in the Tool Properties view.

Icon Tool Name Description

Perspective Tool Options

Selection Mode

Allows you to choose the method to visually select multiple elements:

 l Lasso: Allows you to select multiple elements by drawing 

an irregular closed shape around them with your mouse.

 l Marquee: Allows you to select multiple elements by 

drawing a rectangle around them. This is faster, as you only 

need to drag your mouse from one corner of the rectangle to 

its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the other 

selection mode.

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to 

select which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 
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Icon Tool Name Description

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hile moving the selection or one of its 

control points, it w ill snap against the nearby points and 

contours of your artwork, allow ing you to snap parts of your 

artwork together. 

 l Snap to Alignment Guides: W hile moving the selection or one 

of its control points, it w ill snap against nearby alignment 

guides.

 l Snap and Align: W hen enabled, while moving a selection, the 

rectangular bounding box of the selection w ill snap to the 

rectangular bounding box of any other drawing stroke in the 

drawing, allow ing you to align drawing strokes laterally.

 l Snap to Grid: W hile moving the selection, the mouse cursor 

w ill snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 

from the top menu or press Ctrl + '.

Apply to Line and Colour 

Art

Allows you to perform drawing operations on both the Line Art and 

Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they w ill 

also be affected when this option is enabled.

Deformation Mode

Allows you to select between one of the two follow ing deformation 

modes:

 l  Perspective: Deforms the selection by simulating a 

perspective effect. 

 l  Lattice: Deforms the selection by simply making the 

artwork fit the bounding box, w ithout applying a perspective 

effect. 

The difference between both modes becomes easier to understand if 
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Icon Tool Name Description

you apply a transformation to a drawing of a grid to make it look like 

it 's laid down on a surface: 

Operations

Flip Horizontal Flips the selection horizontally.

Flip Vertical Flips the selection vertically.

Rotate 90 CW Rotates the selection 90° clockwise.

Rotate 90 CCW Rotates the selection 90° counterclockwise.

173

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

Polyline Tool Properties

The Polyline tool allows you to draw complex lines or shapes by defining each point and their Bezier handles 

one by one. 

How to access the Polyline tool properties

 1. In the Tools toolbar, select the Polyline  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil l ines. Hence, its tool properties are similar to the ones of the 

Pencil tool and it can be used w ith pencil presets.

Icon Property Description

  Preview Area

The Preview area lets you see a preview of the stroke your drawing tool 

w ill make.
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Pencil Properties 

Dialog

The arrow button right of the preview area opens the Pencil Properties 

dialog. 

W hile the Tool Properties view only gives you access to the pencil size, 

a list of pencil presets and other drawing options, the Pencil Properties 

dialog gives you access to all the available options for your pencil 's 

shape and texture. For more information on the Pencil Properties dialog, 

see the Polyline Tool Properties section below.

  Size Defines the w idth of the pencil l ine used to draw the shape.

Pencil Presets

Icon Property Description

  Presets list

Harmony provides a variety of presets and also lets you create and save 

your own. It is a good idea to create and save pencils w ith precise sizes 

and parameters when you draw and design for efficiency and 

consistency. 

All tools using pencil l ines share the same preset list. Therefore, the 

Polyline, Line, Rectangle, Ellipse, and Pencil tools share the same preset 

list.

New Preset Creates a new preset based on the current tool properties. 

Delete Preset Deletes the currently selected preset.

Presets Menu Gives access to more options for managing presets.

  Rename Brush Allows you to rename the currently selected preset.

  Import Brushes Allows you to import brush presets exported from Harmony.

  Export Brushes Allows you to export your brush presets into an .xml file. 

  Small Thumbnail Displays presets in a grid of small thumbnails w ith a preview of their tip.

175

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

  Large Thumbnail
Displays presets in a grid of big thumbnails, w ith their name and a 

preview of their tip.

  Stroke View
Displays presets in a list, w ith their name and a preview of a stroke done 

w ith each preset. 

Drawing Options

Icon Property Description

Snap to Contour

W hen this option is enabled, clicking close to a contour in your drawing 

w ill add the point to that contour. The line you are building w ill be linked 

to that contour.

If this option is disabled, attempting to click on existing contours w ill 

always create a point very close to that contour, but not exactly on it. 

Therefore, it is necessary to enable this mode if you want to create lines 

that branch from into existing contours in your drawing.

NOTE 

If you draw a line w ith the Line tool and make its tip snap to a 

contour or another control point in your artwork, they w ill be 

locked together. You can then manipulate both simultaneously 

using the  Contour Editor  tool. You can also separate two 

drawing strokes that have been snapped together by selecting 

one of them with the  Select  tool and moving it away.

Auto Fill

W hen enabled, drawing a closed shape w ill automatically fil l it w ith the 

currently selected Paint colour. 
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TIP 

By default the pencil l ine and its fil l w ill be the same colour. To 

select different colours for the line and its fil l, do the follow ing:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 

the colour list, select the desired colour swatch for your 

outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 

colour list, select the desired colour swatch for the fil l. 

Trim Extra Lines

W hen enabled, drawing a closed shape w ill automatically remove the 

outstanding  lines. 

Align Handles After 

Trim

W hen the Trim Extra Lines option is enabled, enable this option to make 

the point where the beginning and end of the stroke meet into a smooth 

curve rather than a hard corner. 

Automatically Create 

Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art 

layer.

Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 

as a separate drawing object, which can be edited independently from 

other parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 
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NOTE 

Using the Select tool, you can use select and remove a segment of 

flattened pencil l ines. Overlapping pencil l ines drawn with the 

Auto-Flatten mode are essentially cut into segments by the 

overlap and can be treated as individual lines.

Pencil Properties Dialog

The Polyline tool draws the same type of line as the Pencil tool. Hence, you can configure the Polyline tool's 

lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the stroke 

display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil 's size, its smoothing parameters as well as the 

shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil l ine. If the tool is used w ith a pressure 

sensitive pen tablet, the w idth of the stroke w ill vary between its maximum size and 

minimum size depending on the amount of pressure used. If used w ith a mouse, the 

w idth of the stroke w ill always be its maximum size. 

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you 

do not have pressure sensitivity from a pen table, the minimum size value w ill be 

ignored. 

Proportional to Camera

If you check this option, the size of the pencil w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

pencil w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the pencil w ill be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

pencil stroke. A higher setting w ill prevent your line from being shaky and w ill reduce 

the amount of control points it has, making it easier to tweak, but is liable to reduce 

drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the pencil stroke. 

A pencil l ine is defined by its centreline and its variations in thickness, rather than its 

apparent shape. W hen drawing a pencil l ine w ith a mouse, its thickness is uniform. 

Therefore, its outer contour does not have any control point, except at its extremities, 

and no smoothing is required for its contour. 

However, when drawing a pencil l ine w ith a pressure sensitive tablet, its contour w ill 

have control points and Bezier curves to define the line's variations in thickness, and 

thus smoothing must be performed on its contour. An increased contour smoothing 

w ill reduce the amount of control points on the line's thickness and smoothen its 

curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 
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Property Description

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can 

choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 

pencil texture palette to use w ith the Pencil tool. You can also add, remove or rename textures, save the 

current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 

Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 

Colour view—see Colour View  on page 239. 

Icon Property Description

Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.
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Icon Property Description

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 

texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 

the current pencil texture palette. The pencil texture's effect on your 

pencil l ine w ill be based on the image's transparency channel, and w ill 

follow your pencil l ines on its horizontal axis. This option is also 

available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 

This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 

texture palette. This option is also available from the menu button.

  Pencil Texture Display
Displays the pencil textures in the current pencil texture palette and 

allows you to select one to use w ith the Pencil tool.

  Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for 

reference. To select a different pencil texture palette, you must select it 

in the Colour view—see Colour View  on page 239.
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Rectangle Tool Properties

The Rectangle tool allows you to quickly draw a rectangle or a square.

How to access the Rectangle tool properties

 1. In the Tools toolbar, select the Rectangle  tool.

The tool's properties are displayed in the Tool Properties view.

Pencil Properties

Just like other shape tools, this tool creates pencil l ines. Hence, its tool properties are similar to the ones of the 

Pencil tool and it can be used w ith pencil presets.

Property Description

Preview Area

The Preview area lets you see a preview of the stroke your drawing tool w ill make.

Pencil Properties 

Dialog
The arrow button right of the preview area opens the Pencil Properties dialog. 
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Property Description

W hile the Tool Properties view only gives you access to a few of the pencil properties, 

a list of pencil presets and other drawing options, the Pencil Properties dialog gives you 

access to all the available options for your pencil 's shape and texture. For more 

information on the Pencil Properties dialog, see the Pencil Properties Dialog on page 

187 section below.

Size Defines the w idth of the pencil l ine used to draw the shape.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. You 

can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can choose 

between Round, Mitre and Bevel style.

Drawing Options

These options affect the way your shape is added to your artwork.

Icon Property Description

Draw Behind
W hen enabled, your brush strokes w ill appear behind the existing 

artwork. 
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Icon Property Description

NOTE 

Your brush stroke w ill temporarily appear over your artwork as 

you draw it, until you release the mouse cursor or tablet pen. 

Auto Fill

W hen enabled, the shape you draw is automatically fil led w ith the 

selected colour. By default, drawing a shape only creates its outlines. 

TIP 

By default the pencil l ine and its fil l w ill be the same colour. To 

select different colours for the line and its fil l, do the follow ing:

 1. In the Colour view, click the Unlock Three Colours  button.

 2. Click on the  Set Current Pencil Colour swatch. Then, in 

the colour list, select the desired colour swatch for your 

outline.

 3. Click on the  Set Current Paint Colour swatch. Then, in the 

colour list, select the desired colour swatch for the fil l. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 

modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping modes:
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Icon Property Description

 l Snap to Contour: W hen enabled, while you're drawing, the 

mouse cursor w ill snap to the nearby contours of the artwork in 

your drawing. 

 l Snap to Alignment Guides: W hile drawing, the drawing tool 

w ill snap against nearby alignment guides.

 l Snap and Align: W hen enabled, while you're drawing, the 

mouse cursor w ill automatically align to the rectangular 

bounding boxes of other strokes and shapes in your drawing.

 l W hen enabled, while you're drawing, the mouse cursor w ill snap 

against the intersecting points of the grid.

TIP 

To display the grid, select View > Grid > Show Grid from 

the top menu or press Ctrl + '.

Automatically Create 

Colour Art 

As you draw in the Line Art layer, the Automatically Create Colour Art  

option instantly creates the corresponding strokes in the Colour Art 

layer.

Auto Flatten Mode

By default, when drawing on a vector layer, each new stroke is created 

as a separate drawing object, which can be edited independently from 

other parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 
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Icon Property Description

NOTE 

Using the Select tool, you can use select and remove a segment of 

flattened pencil l ines. Overlapping pencil l ines drawn with the 

Auto-Flatten mode are essentially cut into segments by the 

overlap and can be treated as individual lines.

Use Stored Colour 

Gradient

The Use Stored Colour Gradient  option can be used when painting w ith 

a gradient colour to always position the gradient in the same way it was 

stored, making it consistent across brush strokes. You can store a 

gradient by selecting a zone painted w ith a gradient w ith the Select tool, 

then clicking on Store Colour Gradient  in the Tool Properties view.

Draw Square

W hen enabled, the rectangle tool w ill always draw a rectangle of equal 

w idth and height, making it a perfect square.

TIP 

You can also draw a perfect square by holding the Shift key while 

drawing.

Pencil Presets

These options allow you to select, create and manage pencil presets.

Icon Property Description

  Presets list

Harmony provides a variety of pencil presets and thickness stencils and 

also lets you create and save your own. It is a good idea to create and 

save pencils w ith precise sizes and parameters when you draw for 

efficiency and consistency.

A thickness stencil saves the thickness information across the length of 

the line.  W hen drawing w ith a thickness stencil, the pressure sensitivity 

of the tablet is discarded. A thickness stencil can be used while drawing, 

or applied afterwards.

You also have the possibility to apply different textures to your lines by 

either using the default presets or to import your own.

You can  export the pencil presets that you have created and import 

those that others have created. This is a good way for you and project 

collaborators to keep a consistent look for the project.
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Icon Property Description

New Brush Preset Creates a new preset based on the current tool properties. 

Delete Brush Preset Deletes the currently selected preset.

Brush Presets Menu

Open a menu that contains the follow ing options:

 l New Brush Preset: Creates a new preset based on the current 

tool properties. 

 l Delete Brush: Deletes the currently selected preset.

 l Rename Brush: Allows you to rename the currently selected 

preset.

 l Import Brushes: Allows you to import brush presets exported 

from Harmony.

 l Export Brushes: Allows you to export your brush presets into an

 .xml file. 

 l Small Thumbnail: Displays presets in a grid of small thumbnails 

w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 

Pencil Properties Dialog

The Rectangle tool draws the same type of line as the Pencil tool. Hence, you can configure the Rectangle 

tool's lines using the Pencil Properties dialog, which you can open by clicking on the arrow button right of the 

stroke display area in the Tool Properties view.

Size and Smoothness Tab 

The Size and Smoothness tab allows you to select your pencil 's size, its smoothing parameters as well as the 

shape of its tips and corners. 
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Property Description

Maximum Size

Defines the maximum size of the pencil l ine. If the tool is used w ith a pressure 

sensitive pen tablet, the w idth of the stroke w ill vary between its maximum size and 

minimum size depending on the amount of pressure used. If used w ith a mouse, the 

w idth of the stroke w ill always be its maximum size. 

Minimum Size

Defines the minimum size of your stroke as a percentage of the maximum size. If you 

do not have pressure sensitivity from a pen table, the minimum size value w ill be 

ignored. 

Proportional to Camera

If you check this option, the size of the pencil w ill be adjusted to the position of the 

camera on the z-axis. This means that if the camera is zoomed in on the scene, the 

pencil w ill be proportionally smaller so that it appears the same size in the rendered 

image. Likewise, if the camera is zoomed out, the pencil w ill be proportionally bigger. 

Centerline Smoothing

Defines the amount of smoothing Harmony should perform on the central l ine of the 

pencil stroke. A higher setting w ill prevent your line from being shaky and w ill reduce 

the amount of control points it has, making it easier to tweak, but is liable to reduce 

drawing precision and turn sharp angles into curves.

Contour Smoothing

Defines the amount of smoothing Harmony should perform on the outer contour of 

the pencil stroke. 

A pencil l ine is defined by its centreline and its variations in thickness, rather than its 

apparent shape. W hen drawing a pencil l ine w ith a mouse, its thickness is uniform. 

Therefore, its outer contour does not have any control point, except at its extremities, 

and no smoothing is required for its contour. 

However, when drawing a pencil l ine w ith a pressure sensitive tablet, its contour w ill 

have control points and Bezier curves to define the line's variations in thickness, and 
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Property Description

thus smoothing must be performed on its contour. An increased contour smoothing 

w ill reduce the amount of control points on the line's thickness and smoothen its 

curves, but may affect the precision of the variations in line thickness.

Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the first tip you drew. 

You can choose between Round or Flat style.

 l End: Lets you select the style of the end tip, which is the last tip you drew. 

You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the line curves 

abruptly. You could also define the Join style as the corner style. You can 

choose between Round, Mitre and Bevel style.

Texture Tab 

In the Pencil Properties view, the Texture tab allows you to select a pencil texture from the currently selected 

pencil texture palette to use w ith the Pencil tool. You can also add, remove or rename textures, save the 

current pencil texture palette as the default one, or import the pencil texture palette into your scene.

The pencil texture palette used in the Texture tab of the Pencil Properties dialog is the one selected in the 

Colour view. You can select a pencil texture palette by selecting it from the pencil texture palette list in the 

Colour view—see Colour View  on page 239. 
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Icon Property Description

Use as Default Pencil 

Texture Palette

This option is available from the menu button. Sets the currently 

selected pencil texture palette as the default pencil texture palette in 

your user preferences. The default pencil texture palette is added to 

every scene you create in Harmony. The palette is copied in your 

preferences, so it w ill be added to your new scenes in the exact state it 

is when you make it the default pencil texture palette.

Reload Default Texture 

Palette

Imports the default pencil texture palette as a new pencil texture 

palette into your scene's palette list, and selects it as the current pencil 

texture palette.

New Texture

Allows you to import an image file into a new pencil texture swatch in 

the current pencil texture palette. The pencil texture's effect on your 

pencil l ine w ill be based on the image's transparency channel, and w ill 

follow your pencil l ines on its horizontal axis. This option is also 

available from the menu button.

Delete Texture
Deletes a pencil texture swatch from the current pencil texture palette. 

This option is also available from the menu button.

  Rename Texture
Renames the selected pencil texture swatch in the current pencil 

texture palette. This option is also available from the menu button.

  Pencil Texture Display Displays the pencil textures in the current pencil texture palette and 
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allows you to select one to use w ith the Pencil tool.

  Pencil Texture Palette

Displays the name of the currently selected pencil texture palette, for 

reference. To select a different pencil texture palette, you must select it 

in the Colour view—see Colour View  on page 239.
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Reposition All Drawings Tool Properties

W hen you use the Reposition All Drawings tool, its properties and options appear in the Tool Properties view. 

Tool Options

Icon Option Description

Easy Drag

W hen enabled, you can drag the selection by clicking anywhere inside its 

bounding box. By default, you must click on the artwork in the selection to be 

able to drag it. 

Apply to 

Synced 

Drawing Layers

If the currently selected layer is synced w ith another layer, the tool w ill work on 

both the current layer and its synced layer. 

Operations

Icon Option Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 

Degrees CW
Rotates the current selection 90 degrees clockwise.

Rotate 90 

Degrees CCW
Rotates the current selection 90 degrees counter-clockwise.

  Offset X and Y
Use the Offset X and Offset Y operation fields to enter specific values and 

precisely reposition the selected shape.
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 1. X: Type a value in this field to reposition your selection along the X-

axis.

 2. Y: Type a value in this field to reposition your selection along the Y-

axis.

 3. Up/Down arrows: Use the up and down arrows to modify the value in 

the X or Y value field.

  W idth and Height

Use the W idth and Height operation fields to enter specific values to resize 

the selected shape w ith precision.

 1. W idth: Type a value in this field to resize the w idth of your selection.

 2. Height: Type a value in this field to resize the height of your selection.

 3. Up/Down arrows: Use the up and down arrows to modify the value in 

the W idth or Height fields.

 4. Lock icon: Click the lock icon to lock or unlock the ratio between the 

W idth and Height values.

  Angle

The Angle operation lets you to enter specific values and accurately rotate the 

selected shape.

 1. Angle: Type a degree value in this field to rotate your selection.

 2. Up/Down arrows: Use the up and down arrows to modify the value in 

the Angle value field.
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Select Tool Properties

The Select tool lets you select strokes and apply basic transformations such as repositioning, rotating, scaling 

or skewing, using the different handles of the bounding box.

If you have text or pencil l ines selected w ith the Select tool, their properties w ill display in the Tool Properties 

view, allow ing you to make changes to your selection.

How to access the Select tool properties

 1. In the Tools toolbar, select either the Select  tool or the Select by Colour  tool. 

The tool's properties are displayed in the Tool Properties view.

NOTE 

Selecting the Select by Colour  tool from the Tools toolbar activates the Select tool, w ith the 

Select by Colour option enabled. Hence, this topic covers the tool properties for both the Select 

and Select by Colour tools. 
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Tool Options

Icon Property Description

Selection Mode

Allows you to choose the method to visually select multiple 

elements:

 l Lasso: Allows you to select multiple elements by 

drawing an irregular closed shape around them with your 

mouse.

 l Marquee: Allows you to select multiple elements by 

drawing a rectangle around them. This is faster, as you only 

need to drag your mouse from one corner of the rectangle to 

its opposite corner, but it may not be as precise as you want.

TIP 

You can press and hold the Alt key to temporarily use the 

other selection mode.

Easy Drag

W hen enabled, you can drag the selection by clicking anywhere 

inside its bounding box. By default, you must click on the artwork in 

the selection to be able to drag it. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to 

select which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can 

also click on this button to toggle it off, which w ill disable all 

snapping modes, and click on it again and toggle it on to re-enable 

the snapping modes which were previously enabled. 

This tool supports the follow ing snapping modes:

 l Snap to Contour: W hile moving the selection or one of its 

control points, it w ill snap against the nearby points and 

contours of your artwork, allow ing you to snap parts of your 

artwork together. 

 l Snap to Alignment Guides: W hile moving the selection or 

one of its control points, it w ill snap against nearby 

alignment guides.

 l Snap and Align: W hile moving the selection, the rectangular 

bounding box of the selection w ill align w ith the rectangular 

bounding boxes of other strokes and shapes in your artwork. 

195

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

Icon Property Description

If you move one of your selection's control points, it w ill also 

align w ith the bounding boxes of other strokes and shapes in 

your artwork.

 l Snap to Grid: W hile moving the selection, the mouse cursor 

w ill snap against the intersecting points of the grid. 

TIP 

To display the grid, select View > Grid > Show Grid 

from the top menu or press Ctrl + '.

Scale Pencil Line 

Thickness

W hen enabled, the w idth of pencil l ines w ill be adjusted when 

scaling them with the Select tool.

TIP 

You can quickly enable this mode by selecting the Scale 

Pencil Line Thickness  tool, in the Select  tool's 

properties dialog.

Select by Colour

W hen enabled, clicking on a coloured zone in your artwork w ill 

instantly select all the zones that are fil led w ith the same colour.

Select by Colour can also be accessed from the Tools toolbar.
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NOTE 

Only the zones painted w ith the same colour swatch in your 

palette w ill be selected. If another zone is coloured w ith the 

exact same colour, but not the same colour swatch, it w ill not 

be selected.

Permanent Selection

Allows you maintain a selection while editing multiple drawings. 

Once this option is enabled, the selection zone made using the 

Select tool w ill remain as you navigate through drawings of the 

same layer and drawings from other drawing layers. 

Apply to Visible Drawing 

Layers

This option allows you to select which layers the tool should affect. 

It can be toggled on or off. W hen toggled on, it has two different 

modes. You can select a mode by clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on 

the currently selected layers. If several layers are selected, 

the tool w ill work on all these layers simultaneously. 

 l On W hen this button is toggled on, the tool w ill work on all 
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Icon Property Description

the visible layers.

 l  Apply to Visible Drawing Layers: The tool w ill work on 

all the visible layers in the Camera view.

 l  Apply to Synced Drawing Layers: If the currently 

selected layer is synced w ith another layer, the tool w ill 

work on both the current layer and its synced layer. 

NOTE 

This option only works in the Camera view. 

Apply to All Frames

This option allows you to determine which drawings in the current 

layer the tool should affect. It can be toggled on or off. W hen 

toggled on, it has two different modes. You can select a mode by 

clicking and holding on the button.

 l Off: W hen this button is toggled off, the tool only works on 

the drawing in the current frame.

 l Apply to All Frames: The tool w ill work on every 

exposed drawing in the selected layer simultaneously.

 l Apply to Onion Skin Range: The tool w ill work on every 

drawing displayed in the Onion Skin. Onion Skin must be 

enabled for this option to work. 
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Apply to Line and Colour 

Art

Allows you to perform drawing operations on both the Line Art and 

Colour Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they 

w ill also be affected when this option is enabled.

Operations

Icon Property Description

Flip Horizontal Flips the current selection horizontally.

Flip Vertical Flips the current selection vertically.

Rotate 90 Degrees CW Rotates the current selection 90 degrees clockwise.

Rotate 90 Degrees CCW Rotates the current selection 90 degrees counter-clockwise.

Smooth

Smooth out selected drawing strokes and remove extra points.
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Flatten 

Merges drawing objects and brush strokes into a single layer. If you 

draw new lines to fix a drawing or line w ith many brush strokes, it 

can be useful to flatten them all into a single shape. By default, l ines 

are drawn one on top of each other. If you intend to repaint the lines 

or modify their shape, it w ill be easier if they are flattened. 

Create Colour Art from 

Line Art

Lets you use the outline you traced on one of the four embedded 

layers (line art, colour art, overlay, underlay) and create invisible 

strokes to paint your drawings on separate layers. This provides 

more inking and painting flexibility. 

You can also configure this option to create the invisible strokes on 

any of the four embedded layers.

Store Colour Gradient 

Use the Store Colour Gradient  operation to record the selected 

gradient’s position. This reuses the stored position of the gradient 

when drawing new brush lines or painting colour zones. Enable the 

Use Stored Colour Gradient  option in the Paint or Brush Tool 

Properties view to do this.

Pencil to Brush

Converts the selected centre line pencil strokes into contour strokes 

brush lines.

Merge Pencil Lines

Because pencil l ines are defined by their centre lines, two pencil 

l ines that brush against each other may not actually make a closed 

shape, even if they appear closed. If you select several pencil l ines 
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that are close together, you can use this button to close the small 

gaps between these pencil l ines and make them into a single pencil 

l ine.

 

NOTE 

Points must be close enough to be merged. If there is a large 

gap between the lines, they w ill not be merged.

Reverse Pencil Thickness

The Reverse Pencil Thickness  option inverts the thick and thin 

section on a selected pencil l ine. This option w ill take the thickest 

size on the line and apply it to the thinnest, and it w ill apply the 

thinnest to the thickest.

Offset X Lets you enter a value to reposition the selection along the X-axis.

Offset Y Lets you enter a value to reposition the selection along the Y-axis.

W idth Lets you enter a value to resize the w idth of the selection.
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Height Lets you enter a value to resize the height of the selection.

Lock Locks or unlocks the ratio between the W idth and Height values.

Angle

Lets you enter specific values to rotate the selection. A positive value 

rotates the selection counter clockwise and a negative value rotates 

the selection clockwise. 

Pencil Selection

If the selection contains pencil l ines, the Pencil Selection section appears at the bottom of the Tool Properties 

view, allow ing you to adjust the properties of those pencil l ines.

Icon Property Description

  Maximum Size

Adjusts the size of the parts of the pencil l ines that are the thickest. 

Parts of the pencil l ines that are between the minimum and 

maximum sizes w ill be adjusted proportionally.
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  Minimum Size

Adjusts the size of the parts of the pencil l ines that are the thinnest. 

Parts of the pencil l ines that are between the minimum and 

maximum sizes w ill be adjusted proportionally.

  Pencil Line Shape

You can adjust the start, end, and join  style of a pencil l ine.

 l Start: Lets you select the style of the start  tip, which is the 

first tip you drew. You can choose between Round or Flat 

style.

 l End: Lets you select the style of the end tip, which is the last 

tip you drew. You can choose between Round or Flat style.

 l Join: Lets you select the joint style. The joints are where the 

line curves abruptly. You could also define the Join style as 

the corner style. You can choose between Round, Mitre and 

Bevel style.

  Pencil Stencils

Allows you to apply one of the available line thickness stencils to 

the selected pencil l ines. Stencils set the w idth of a pencil l ines all 

along its length. You can use one of the preloaded presets, or create 

your own pencil stencils. 

 
Adding Texture to a 

Pencil Line

Pencil l ines support texture. Once a pencil l ine is drawn, you can 

apply a preset texture or load your own. Textures are independent 

from pencil stencils.

Text Selection

If your selection include text boxes created w ith the Text tool, a Text Selection section w ill appear at the 

bottom of the Tool Properties view, allow ing you to adjust the formatting of the whole text box. 
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TIP 

You can also adjust the formatting of parts of the text in the text box using the Text tool—see Text 

Tool Properties on page 222.

Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic

Makes the selected text italic.

Align Left

Aligns the text in the selected text box to the left.
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Align Center

Aligns the text in the selected text box to the centre.

Align Right

Aligns the text in the selected text box to the right.

Justify

Makes the text in the selected text box take all the horizontal space by 

adjusting the spacing between each word. Text that use a single line 

and text in the last line of a paragraph is aligned to the left.

  Size

Allows you to set the size of the selected text.

  Kerning
Allows you to increase or decrease the spacing between each 

character.

205

Harmony 22 Paint Reference Guide                          



Chapter 2: Tools Properties

Icon Property Description

  Auto Kern
Sets the kerning automatically based on the font’s predefined 

standard. 

  Indent

Allows you to increase or decrease the indentation of the first l ine of 

text in each paragraph.

  Line Spacing

Increases or decreases the space between each line of text.
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Shift and Trace Tool Properties

The Shift and Trace tool allows you to temporarily move, rotate and scale drawings, then trace over them in 

other drawings, using Onion Skin to keep the outlines of the shifted drawings in your drawing space.  Contrary 

to Shift and Trace w ith the Drawing Desk, you can use the Shift and Trace tool in the Camera view. 

How to access the Shift and Trace Tool Properties

 1. Do one of the follow ing:

 l In the Tools toolbar, double-click on the Hand  tool and select Shift and Trace  in the 

pop-up menu.

 l In the top menu, select Drawing > Drawing Tools > Shift and Trace.

The Shift and Trace tool properties appear in the Tool Properties view. 

Icon Tool Name Description

Shift and Trace Tool Options

Enable/Disable Shift 

and Trace

Enabled by default. W hen disabled, drawings that were repositioned, 

rotated or scaled w ith the Shift and Trace tool appear in their original 

position.

Display Cross Hair
Enabled by default. W hen disabled, cross hairs added w ith the Shift and 

Trace tool are invisible. 

Show manipulators 

for shift and trace

Enabled by default. This displays the manipulator allow ing you to rotate 

and scale drawings for Shift and Trace, as well as to re-position their pivot 
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Icon Tool Name Description

point. W hen hidden, you can only shift drawings laterally. 

Show the outline of 

the selected shift and 

trace drawing

W hen enabled, the contours of each brush stroke for the current drawing 

w ill appear highlighted in cyan.

Show/Hide Pegs

Enabled by default. W hen using the Shift and Trace tool, peg holes are 

displayed at the bottom of every drawing to help keep track of how offset 

drawings are from their original position and from each other. You can 

also click and drag on the left or right peg hole of a drawing to rotate it 

around the centre peg hole. W hen disabled, those peg holes are hidden.

Peg Position
Allows you to select on which edge of the drawings to display peg holes. 

By default, they are displayed at the bottom of the drawings.

Modes and Operations

Set Add Cross Hair 

Mode

W hen selected, clicking on the drawing w ill add a cross hair where you 

click. Cross hairs are marks that appear on the same location on every 

drawing in the current layer and which move when you offset a drawing 

w ith the Shift and Trace tool, and they appear in the Onion Skin rendition 

of neighbouring drawings as well. This allows you to keep track of how 

offset each drawing is. 

Remove All Cross 

Hair
Removes all the cross hairs created for shift and trace.

Reset Selected 

Drawings Shift 

Position

Undoes all transformations done w ith the Shift and Trace tool on the 

selected drawings, resetting them to their original position, angle and 

scale.

Reset All Drawings 

Shift Position

Undoes all transformations done w ith the Shift and Trace tool on all 

drawings, resetting them to their original position, angle and scale. 

Info

Selected Drawings The element name and drawing name of the currently selected drawing.

Position The offset of the current drawing from its original position on the x and y 
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axes, in fields, when moved w ith the Shift and Trace tool.

Scale
The Shift and Trace scale factor of the currently selected drawing, when 

scaled w ith the Shift and Trace tool.

Rotation
The Shift and Trace rotation angle of the currently selected drawing, in 

degrees, counterclockwise, when rotated w ith the Shift and Trace tool.

Pivot

The offset, in fields, of the current drawing's pivot point from its centre, on 

the x and y axes. The pivot point is the point from which drawings are 

rotated and scaled.
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Smooth Editor Tool Properties

W hen you select the Smooth Editor tool, its properties and options appear in the Tool Properties view. 

Icon Tool Name Description

Smoothing Style 

The Smoothing Style options allow you to smooth a 

portion of your drawing by tracing a smoothing stroke 

over the zone to optimize or by selecting an area of 

the drawing w ith the Marquee or Lasso.

Note that by default, the Smooth Editor tool colour is 

yellow, it was changed to orange for screen grab 

clarity.

Show Control Points 

The Show Control Points  option allows you to show 

or hide the Bezier points around lines. W hen the 

Bezier points are displayed, you can see the result of 

your smoothing and the number of points left on the 

curve. W hen it is turned off, only the original artwork 

is displayed.

 
Minimum Size and 

Maximum Size 

This is where you set the minimum and maximum 

sizes of your drawing tool which w ill produce the thick 

and thin effect on your stroke. This works w ith the 

pressure sensitivity of a pen tablet.

This options is available while using the Brush 

Smoothing  style.

 l Maximum and Minimum Size: Defines the 

maximum and minimum width of the stroke.
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 l Up/Down arrows: Use the up and down 

arrows to set the minimum and maximum size 

value.

Smoothness 

The Smoothness impacts the strength of the 

smoothing result. The higher the value, the more 

points are removed and the smoother the curve. The 

Smoothness range is from 0 to 100; the default value 

is 20.

  Colour 

You can modify the colour of the control points 

displayed on the artwork while working w ith the 

Smooth Editor tool by double-clicking on the colour 

swatch.
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Stamp Tool Properties

The Stamp tool allows you to create and use stamps, which can contain one or several drawings that can be 

stamped individually or in sequence onto your artwork.

How to access the Stamp tool properties

 1. In the Tools toolbar, select the Stamp  tool.

The tool's properties are displayed in the Tool Properties view.

Stamp Properties

The follow ing options allow you, among other things, to preview your stamp, to change the size of your stamp 

as well as to fl ip it horizontally and vertically.

Property Description

Preview Area

The Preview area lets you see a preview of what w ill appear if you draw a stroke w ith the 

Stamp tool.
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Stamp Properties 

Dialog

The arrow button right of the preview area opens the Stamp Properties dialog. 

W hile the Tool Properties view only gives you access to a few of the stamp properties and a 

list of stamp presets, the Stamp Properties dialog gives you access to all the available options 

for the way your stamp will be applied. For more information on the Stamp Properties dialog, 

see the Stamp Properties Dialog on page 216 section below.

Flip Horizontally 

/ Flip Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 

horizontally or vertically.

Maximum Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was used 

to create the stamp. This means that, at 100%, the drawing w ill be stamped into your artwork 

in its original size.

NOTE 

If the tool is used w ith a pressure sensitive tablet, the scale of the stamp can be made to 

be relative to the amount of pressure you put on your pen. To do this, you must reducing 

the Minimum Scale property of your stamp in the Stamp Properties dialog. If the 

Minimum Scale setting is left at its default value, which is 100%, the size of the stamp 

will not vary.

Stamp

W hen using a multi-drawing stamp, this is the number of the drawing in the series that w ill 

be stamped on the next time you use the Stamp tool. For example, if your stamp has 3 

drawings and this is set to 2, the next drawing that w ill be stamped on is the second drawing 

in the series. 

If your stamp's Cycle setting is set to Hold, then you have to use this slider to select which 

drawing to stamp with the Stamp tool. 

If your stamp's Reset Cycle for Each Stroke option is enabled, then you can use this slider to 

select which drawing to start each stroke w ith.

Otherwise, when you draw a stroke w ith the Stamp tool, the Stamp slider w ill automatically 
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Property Description

update to the next drawing in the sequence.

TIP 

You can also cycle through the drawings in your stamp by using the Left Arrow and Right 

Arrow keys. 

NOTE 

The Cycle and Reset Cycle for Each Strokee options are available in the Stamp 

Properties dialog. 

Stamp Presets

These options allow you to select, create and manage stamp presets. 

Contrary to the Brush and Pencil tools, creating a Stamp preset is required to use the Stamp tool, as this 

preset w ill contain the drawings to stamp onto your artwork. A Stamp preset is created by selecting one or 

several layers, then adding a preset to the Stamp Presets list. If several layers are selected, the Stamp will 

contain a series of drawings, which it w ill stamp onto your artwork in a sequence as you draw strokes w ith the 

Stamp tool. 

Icon Property Description

  Presets list
The list of Stamp presets. Click on one of the presets to select it and 

use it in your drawing. 

New Brush Preset

Creates a new Stamp preset based on the selected artwork. The 

artwork can either be a selection made with the Select  tool, or by 

selecting a layer. 

If several layers are selected, this w ill create a multi-drawing Stamp. 

As you draw a stroke w ith the Stamp tool using a multi-drawing 

stamp, each drawing in the stamp will be applied onto your artwork, 

one after the other. 

Delete Brush Deletes the currently selected preset.

Brush Presets Menu
Open a menu that contains all of the previous options, along w ith all 

of the follow ing options:
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 l New Brush Preset: Creates a new stamp based on the 

selected artwork.

 l Rename Preset:Allows you to rename the currently selected 

preset.

 l Import Brushes:Allows you to import brush presets exported 

from Harmony.

 l Export Brushes:Allows you to export your brush presets into 

an .xml file. 

 l Small Thumbnail: Displays presets in a grid of small 

thumbnails w ith a preview of their tip.

 l Large Thumbnail: Displays presets in a grid of big thumbnails, 

w ith their name and a preview of their tip.

 l Stroke View: Displays presets in a list, w ith their name and a 

preview of a stroke done w ith each preset. 

Drawing Options

These options affect the way your drawing strokes are added to your artwork

Icon Property Description

Draw Behind

W hen enabled, your brush strokes w ill appear behind the existing 

artwork. 

NOTE 

Your brush stroke w ill temporarily appear over your artwork as 

you draw it, until you release the mouse cursor or tablet pen. 

Snapping

Allows you to enable or disable snapping for this tool and all other 

animation and drawing tools that support snapping, as well as to select 

which types of snapping are enabled. 

If you double-click or long-click on this button, it w ill open a pop-up 

menu in which you can toggle different snapping modes. You can also 

click on this button to toggle it off, which w ill disable all snapping 
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modes, and click on it again and toggle it on to re-enable the snapping 

modes which were previously enabled. 

This tool supports the follow ing snapping mode:

 l Snap to Alignment Guides: W hile drawing, the drawing tool 

w ill snap against nearby alignment guides.

Stamp Properties Dialog

The Stamp Properties dialog allows you to set more specific settings for your stamp, such as pressure 

sensitivity, spacing, angle, randomness and, for multi-drawing stamps, how to cycle through each drawing in 

the stamp. To open the Stamp Properties dialog, click on the arrow button right of the stroke display area.

Property Description

Maximum Scale

The maximum scaling factor to apply to the stamp before stamping it onto the drawing. 

This setting is a percentage, which is relative to the size of the original drawing that was 

used to create the stamp. This means that, at 100%, the drawing w ill be stamped into your 

artwork in its original size.

Minimum Scale The minimum scaling factor to apply to the stamp before stamping it onto your drawing. 
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W hen using the Stamp tool w ith a pressure-sensitive pen tablet, the size of the stamps 

applied onto your artwork w ill vary between its Minimum Scale and Maximum Scale 

properties, relative to the amount of pressure you apply to the pen.

This setting is relative to the Maximum Scale property. This means that if the Maximum 

Scale is set to 50% and the Minimum Scale is set to 50%, the actual scaling factor applied to 

the stamp will vary between 25% and 50%. 

This setting is also used w ith the Random Size setting. 

Flip Horizontally / 

Flip Vertically

The two-ended arrows to the left and over the Stamp thumbnail allow you to flip the stamp 

horizontally or vertically.

Roundness & 

Angle

The Roundness and Angle parameters allow you to change the shape and orientation of the 

stamp.

 l Roundness: The vertical scaling to apply to the stamp. Reducing this setting 

squashes the stamp vertically, allow ing you to turn round or square stamps into flat 

stamps. 

 l Angle: The angle at which to rotate the brush tip, counterclockwise. 

NOTE 

The squashing is not relative to the angle—if the stamp is rotated, the squashing w ill 

stil l be done relative to the stamp's original orientation.

Spacing
Defines the amount of space between each stamp that is applied onto the artwork. The 

larger the value, the greater the space between each stamp. 
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Property Description

Random Size

The percentage of randomness to apply to the size of the stamp. This makes the size of the 

stamp randomly vary between its Maximum Scale and Minimum Scale settings each time it 

is applied to your artwork. 

The greater the value of the Random Size property, the closer to its Minimum Scale the size 

of each stamp can get. For example, if the Random Size setting is set to 50% and the 

Minimum Scale is set to 50%, the size of the stamp will randomly vary between 75% and 

100% of its Maximum Scale. 

Random Angle

The maximum value of randomness to apply to the angle of the stamp. This makes the 

angle of the stamp randomly vary w ithin the range of degrees in this setting, in either 

direction, each time it is applied to your artwork. For example, if the stamp's Angle is set to 

0°, and the Random Angle is set to 180°, each instance of the stamp will be at a random 

angle varying between -90° and 90°.

Random Spacing

The maximum amount of randomness to apply to the spacing of the stamp. Increasing this 

setting makes the distance between each instance of the stamp vary randomly as you draw 

a stroke. At 100%, this makes the distance between each stroke vary between 0% and 

200% of its Spacing property.

Cycle

For multi-drawing stamps, this decides the logic w ith which to cycle through the sequence 

of drawings in the stamp as you draw a stroke.

 l Forward: Starts by applying the first drawing in the sequence, then the next one, 

and so on until it reaches the last drawing in the sequence, then cycles back to the 

first one.
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Property Description

 l Reverse: Starts by applying the last drawing in the sequence, then the previous one, 

and so on until it reaches the first drawing in the sequence, then cycles back to the 

last one.

 l Forward->Reverse: Starts by cycling forward through the sequence until it reaches 

the last drawing, then cycles backward to the first drawing, and so on.

 l Reverse->Forward: Starts by cycling backward through the sequence until it 

reaches the first drawing, then cycles back to the last drawing, and so on.

 l Random: Applies a random drawing in the sequence each time the stamp is applied. 

 l Hold: Applies a single one of the drawings in the sequence over and over again. 

TIP 

W hen this option is set to Hold, you can select which one of the drawings is stamped on 

by changing the Stamp setting in the Tool Properties view.

Reset Cycle for 

Each Stroke

For multi-drawing stamps. This makes it so each stroke you draw with the stamp too always 

starts w ith the first drawing in the cycle, which is decided by the Stamp option in the Tool 

Properties view. 

W hen disabled, the Stamp tool keeps track of which drawing it was going to stamp next 

when you finish drawing a stroke by storing the number of that drawing in the Stamp 

setting. W hen this option is enabled, it simply stops updating the Stamp setting. Hence, 

your strokes always start at the drawing selected w ith that setting. Likewise, you can 

manually decide which drawing to start your strokes w ith by adjusting the Stamp setting.
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Stroke Tool Properties

W hen you select the Stroke tool, its properties and options appears in the Tool Properties view. 

Icon Tool Name Description

Draw Stroke as 

Straight Lines 

Enable the Draw Stroke as Straight Lines  option if you want the new 

strokes you draw to be a perfect straight line. Disable the option if you 

want the stroke to follow the mouse gesture.

Connect Line Ends 

Enable the Connect Line Ends  option if you want the start or end point of 

your new stroke to connect to your existing strokes to make sure no gaps 

are left in your drawing.

Auto Fill

W hen enabled, drawing a closed shape w ill automatically fil l it w ith the 

currently selected Paint colour. 

Trim Extra Lines

W hen enabled, drawing a closed shape w ill automatically remove the 

outstanding  lines. 

Align Handles After 

Trim

W hen the Trim Extra Lines option is enabled, enable this option to make 

the point where the beginning and end of the stroke meet into a smooth 

curve rather than a hard corner. 
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Auto-Flatten Mode

By default, when drawing on a vector layer, each new stroke is created as 

a separate drawing object, which can be edited independently from other 

parts of the artwork. W hen enabled, the Auto-Flatten option 

automatically merges strokes into existing artwork. 

Apply to Line and 

Colour Art

Allows you to perform drawing operations on both the Line Art and Colour 

Art layers of your drawing simultaneously. 

NOTE 

If you have Overlay and Underlay Art layers enabled, they w ill also 

be affected when this option is enabled.

Apply to Synced 

Drawing Layers

If the currently selected layer is synced w ith another layer, the tool w ill 

work on both the current layer and its synced layer. 

  Smoothness

You can modify the central l ine smoothness  of your line using this option. 

This parameter smooths the initial movement of your line. Increasing the 

value w ill result in a smoother line w ith fewer control points. Use the left 

and right arrows to increment the value by one full unit. Use the Up - 

Down slider to quickly increment the value.
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Text Tool Properties

The Text tool lets you add text fields to your project, in which you can type text, then adjust its formatting 

using various fonts and text attributes. 

W ith the Text tool selected, you can select text w ithin text boxes you created and change the formatting of 

the selection. You can also select and manipulate text boxes using the Select tool, and change the formatting 

of the entire text box in the Select tool properties. 

How to access the Text tool properties

 l In the Tools toolbar, select the Text  tool.

The tool's properties are displayed in the Tool Properties view.

Icon Property Description

  Font

Lets you select the font in which to display the text.

Bold

Makes the selected text bold.

Italic Makes the selected text italic.
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Icon Property Description

Align Left

Aligns the text in the selected text box to the left.

Align Center

Aligns the text in the selected text box to the centre.

Align Right

Aligns the text in the selected text box to the right.

Justify

Makes the text in the selected text box take all the horizontal space by 

adjusting the spacing between each word. Text that use a single line 

and text in the last line of a paragraph is aligned to the left.
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Icon Property Description

  Size

Allows you to set the size of the selected text.

  Kerning

Allows you to increase or decrease the spacing between each 

character.

  Auto Kern
Sets the kerning automatically based on the font’s predefined 

standard. 

  Indent

Allows you to increase or decrease the indentation of the first l ine of 

text in each paragraph.

  Line Spacing

Increases or decreases the space between each line of text.
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Zoom Tool Properties

The Zoom tool lets you zoom in and out of the Camera, Drawing, Side and Top views. You can also use it to 

reset the zoom level.

How to access the Zoom tool properties

 1. In the Tools toolbar, select the Zoom  tool.

The tool's properties are displayed in the Tool Properties view.

Tool Options

Icon Parameter Description

Zoom In Mode Use the mouse cursor to zoom in to the Camera or Drawing view.

Zoom Out Mode Use the mouse cursor to zoom out of the Camera or Drawing view.

Operations

Icon Parameter Description

Perform Zoom In
Zoom in the Camera or Drawing view. 

The keyboard shortcut is 2.

Perform Zoom 

Out

Zoom out the Camera or Drawing view. 

The keyboard shortcut is 1.

Reset Zoom Restores the current zoom level to 100%.

Reset View Restores the original display by resetting any pan, rotation or zoom actions.
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Chapter 3: Toolbars

Harmony contains toolbars which, by default, are located at the top of the interface. Some views also have a 

toolbar which you can reposition to suit your work style. You can show or hide toolbars, as well as customize it 

w ith the tools you use most often and hide the ones you don't.

W orkspace Toolbars 227

Edit Toolbar 228

File Toolbar 229

Tool Presets Toolbar 230

Tools Toolbar 231

W orkspace Toolbar 236

View Toolbars 237
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W orkspace Toolbars

Harmony has a series of toolbars that are added by default at the top of the interface. These toolbars can be 

moved on the sides of the interface as well as w ithin specific views. 

All top toolbars can be added by selecting  W indows > Toolbars in the top menu.

Edit Toolbar 228

File Toolbar 229

Tool Presets Toolbar 230

Tools Toolbar 231

W orkspace Toolbar 236
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Edit Toolbar

The Edit toolbar contains common operations such as Undo, Redo, Cut, Copy and Paste. These commands can 

also be found in the Edit top menu.

How to access the Edit toolbar

 1. Select W indows > Toolbars > Edit.

Icon Tool Name Description

Undo

Removes the last change made to your project. 

Harmony supports multiple undo, so you can undo 

changes you made in the order you made them.

Redo
Redoes an operation you have undone. This command 

is active only after you use the Undo command.

Cut
Removes selected objects. You can then paste the 

object or its properties to another object.

Copy Copies selected objects and properties.

Paste
Places an object you cut or copied into the location 

you select in a view.

Create Symbol

Creates a symbol from selected drawing elements in 

the Drawing or Camera view or a layer or cells in the 

Timeline view.
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File Toolbar

The File toolbar contains buttons for common file operations such as New, Save and Open. These commands 

can also be found in the File top menu.

NOTE 

The  New, and  Save As buttons are only available in Harmony Stand Alone. W ith Harmony 

Server,  Control Center must be used to create scenes.

How to access the File toolbar

 1. Select W indows > Toolbars > File.

Icon Tool Name Description

Open

Displays the Open Scene dialog box where you can browse for a 

scene file.  You can open a new scene from the current one and the 

previous scene w ill close.

Save
Saves all changes made to the opened scene, drawings, palettes, and 

palette lists.

Load Background File
Allows you to select an image to temporarily add as a background to 

your drawings, for reference. This background w ill not be in the scene. 
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Tool Presets Toolbar

The Tool Presets toolbar lets you create new tool presets and manage them.

How to access the Tool Presets toolbar

 1. Select W indows > Toolbars > Tool Presets.

Icon Tool Name Description

New Tool Preset
Creates a new tool preset from the current tool 

settings.

Manage Presets
Opens the Manage Tool Preset dialog box where you 

can update, organize, and delete existing presets.
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Tools Toolbar

The Tools toolbar contains the main tools you need to work in Harmony. In the default workspace, this toolbar 

located on the left edge of the application w indow.  

TIP 

Many toolbar buttons have a keyboard shortcut associated to them. You can check which keyboard 

shortcut is associated to a button by leaving your mouse cursor over the button for a second. If the 

button has a keyboard shortcut, it w ill be indicated in the tooltip that appears. 

By default, the Tools toolbar hides some of its tools inside pop-up menus. For example, to select the  Cutter 

tool, you must double-click or long-click the  Select tool button, and select  Cutter in the pop-up menu.

However, it is possible to make the Tools toolbar display each tool as a separate button by enabling the Flat 

Tools Toolbar preference. This makes the selection of tools quicker. 

How to make every tool in the Tools toolbar display in buttons rather than pop-up 
menus

 1. Do one of the follow ing to open the Preferences dialog:

 l W indows or GNU/Linux:

 l In the top menu, select Edit > Preferences.

 l Press Ctrl + U.

 l macOS:

 l In the top menu, select Harmony [Edition] > Preferences.

 l Press ⌘  + U.

 2. Select the General tab.

 3. In the Options section, check the Flat Tool Toolbar option.

 4. Click OK.

 5. Close and relaunch Harmony.
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NOTE 

In Flat Tools Toolbar mode, some tools are hidden from the Tools toolbar by default. To 

customize which tools are displayed in the Tools toolbar, and the order in which they are 

displayed, right-click on the Tools toolbar and select Customize.

How to customize which tools are displayed in the Tools toolbar when it is in Flat 
mode

 1. Right-click on the Tools toolbar and select Customize.

The Toolbar Manager dialog appears. 

 2. In the Available Tools list, select each tool that you want to add to the Tools toolbar, then click on 

the Add the selected tool to the toolbar  button.

 3. In the Toolbar list, select each tool that you want to remove from the Tools toolbar, then click on 

the Remove the selected tool from the toolbar  button.

Tool Name Icon Description

Select
Allows you to select and reposition, scale, rotate and skew brush 

strokes, pencil l ines, shapes and other parts of your artwork.

Cutter
Allows you to cut a part of your artwork, then reposition, scale, 

rotate and skew it. 

Reposition All 

Drawings

Allows you to reposition, scale, rotate and skew all drawings in 

the current layer.
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Contour Editor

Allows you to edit the vector contours of brush strokes, pencil 

l ines and shapes in your artwork. You can add, remove, tweak and 

move vector points, move the Bezier handles of the vector points 

as well as  deform vector outlines. 

Centerline Editor
Allows you to tweak and deform a brush stroke by manipulating 

the points at the centre of its line rather than its contour.

Pencil Editor

Allows you to adjust the thickness of a pencil l ine at its different 

points and corners, tweak the shape of its extremities and scale its 

texture.

Smooth Editor
Allows you to optimize contours and lines by removing its extra 

points, making them easier to edit. 

Perspective
Allows you to deform artwork by applying a perspective effect on 

it.

Envelope
Allows you to deform and warp artwork by moving points and 

tweaking lines in a grid. 

Edit Gradient/Texture
Allows you to adjust the position, angle and size of gradients and 

textures in a colour zone. 

Brush
A pressure-sensitive tool for creating a contour shape w ith a thick 

and thin line effect, as if created w ith a paint brush.

Pencil

A pressure-sensitive tool for  drawing outlines. Pencil l ines are 

made of central vector lines, making them easier to tweak and edit 

than brush strokes. 

Text Allows you to add text and to format it.

Eraser A pressure-sensitive tool for erasing parts of a drawing.

Paint Allows you to fil l colour zones w ith a colour or texture.

Ink
Allows you to recolour pencil l ines w ith precision by changing the 

colour of one segment at a time. 
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Paint Unpainted
Allows you to quickly fil l empty zones in your artwork w ith a 

colour or texture, leaving fil led zones unchanged.

Repaint
Allows you to quickly repaint painted zones in your artwork. 

Empty zones w ill remain empty.

Unpaint
Allows you to empty fil led colour zones of their colour and 

texture.

Stroke
Allows you to create invisible lines that can serve as colour zones 

that can be fil led, or close the gaps in existing colour zones.

Close Gap

Allows you to close open shapes so that they can be fil led w ith 

the Paint tool. By drawing a stroke near a small gap in a shape, 

this tool w ill create a small invisible stroke connecting the two 

closest points around the gap.

Line Draws a straight line segment going from one point to the other.

Rectangle Draws a rectangle. 

Ellipse Draws an ellipse. 

Polyline 

Allows you to draw shapes, segmented lines or complex curved 

lines by clicking to create each point in the sequence of line 

segments. 

Colour Eyedropper
Allows you to select a colour by clicking on a colour in your 

artwork. 

Pencil Texture 

Eyedropper

Allows you to select a pencil texture by clicking on a textured 

pencil l ine.

Drawing Pivot
Allows you to position the pivot on a drawing layer by clicking 

where you want its location to be.

Morphing

Allows you to create and configure a morphing sequence, which 

w ill automatically generate the in-betweens between two 

drawings in the current layer. 
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Hand Allows you to pan the Camera and Drawing views.

Zoom Allows you zoom in and out of the Camera and Drawing views.

Rotate View
Lets you rotate the Camera and Drawing views just like w ith a real 

animation disc.

Shift and Trace
Allows you to temporarily move drawings so you can trace over 

them in other drawings using Onion Skin. 

Animate Current Frame

W hen this option is selected, every time you use the  

Transform or  Advanced Animation tools to 

manipulate an element in your scene, the position of the element 

w ill be stored in a keyframe at the current frame. This allows you 

to animate elements in your scene w ithout creating keyframes 

manually.

Animate Onion Skin 

Range

W hen this option is selected, if you use the  Transform or 

 Advanced Animation tools to make transformations 

to an element in your scene, the transformations w ill be stored as 

keyframes at the beginning and at the end of the current Onion 

Skin range, as well as on every existing keyframe in-between. 

This can be useful if you want to reposition an element that you 

have already animated, but only during a specific range of frames, 

which you can define by enabling Onion Skin and setting the 

Onion Skin range to cover that range of frames.

Animate Off

W hen this option is selected, if you use the  Transform or 

 Advanced Animation tools to make transformation 

to an element in your scene, the transformations w ill affect the 

element throughout the whole scene. This can be useful if you 

want to reposition an element after you have already animated it. 

Transform
Allows you to select drawing layers and position, rotate, scale and 

skew them. 

Onion Skin
Displays the previous and next frames of an animation. Useful 

when animating cut-out characters.

Advanced Onion Skin
Enables Advanced Onion Skin, a more flexible kind of Onion Skin 

that can be easily configured using the Onion Skin view.
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W orkspace Toolbar

The W orkspace toolbar lets you load other workspaces. The first time you start Harmony, the default 

workspace is loaded. Other workspaces are available such as the Hand-Drawn Animation and Compositing 

workspaces; these display different views and toolbars. You can access these workspaces and any you create, 

from the W indows menu and the W orkspace toolbar.

How to access the W orkspace toolbar

 1. Select W indows > Toolbars > W orkspace.

Icon Tool Name Description

  W orkspace List Allows you to select an existing workspace.

W orkspace Manager

Opens the W orkspace Manager where you can 

organize, display, and remove workspace from your 

list.

Save W orkspace

W hen the Automatically Save W orkspace preference 

is disabled, the Save W orkspace button becomes 

available. This allows you to manually save your new 

workspace configuration.
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View Toolbars

Harmony has a series of view specific toolbars that are only available in a given view. These toolbars can be 

moved only w ithin their view. 

All view toolbars can be added, as long as the view is visible, through the top menu W indows > Toolbars > 

desired toolbar.
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Chapter 4: Views

The Harmony interface is composed of different views, each one designed for a specific purpose. You can 

modify the location of the views by adding a new view as a tab or as a w indow. You can also swap the location 

of a view.  

W hen a view is active, a red rectangle appears around the view. Keyboard shortcuts and top menu options are 

associated w ith the active view. If a menu option is greyed out, it means it does not apply to the layer, drawing 

or other type of selection or the option does not apply to the active view.

Colour View 239

Drawing View 246

Integrated Help View 249

Message Log View 250

Reference View 251

Tool Properties View 253
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Colour View

The Colour view is where you create colours and palettes and import existing palettes into your project. The 

Colour view is also necessary for drawing, painting and creating colour styling.

How to access the Colour view

Do one of the follow ing:

 l From the top menu, select W indows > Colour.

 l From any of the other views, click the Add View  button and select Colour.

Palette List Panel

Icon Option Description

View Menu
The View menu contains all the commands and options that you can 

use in the Colour view to manage colours and palettes.
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Collapse/Expand Palette 

List

Allows you to show or hide your palette list and its options. By 

default, the palette list is displayed, but you may want to hide it if you 

are working w ith a single palette and want to allow more vertical 

space for the colour swatch list.

Add Palette Allows you to create a new palette. 

Remove Palette 

Deletes the currently selected palette. If the colour swatch is used in 

your project, zones painted w ith colour swatches which have been 

deleted w ill turn red, easily identifying them so you can repaint them 

with another colour swatch.

Link Palette

Allows you to add a palette from a different location, be it in a scene, 

job, environment or even an element to your palette list. The palette 

w ill be linked to its original location rather than copied to your 

scene's folder. Hence, if you make changes to the original palette, it 

w ill affect the colour of elements in your scene. 

If you want to import a palette as a copy into your scene's palette 

library, right-click on your palette list and select Import. You can also 

link to a palette in any location on your machine or network by 

selecting Link to External.

Order Palette List

Moves palettes further up or down the palette list. 

If a palette has been cloned, the highest palette among the original 

palette and its clone(s) w ill be used by Harmony. 

Edit Palette List Mode 

Indicator

In Harmony Server, this icon appears when you have the modifying 

rights on your scene's palette list. W hile several users can work on a 

scene at the same time, only one user may have the right to modify a 

palette list at any given time. 
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NOTE 

In Harmony Stand Alone, you can always modify your scene's 

palette list. On Harmony Server, you must  unlock your palette 

list before making modifications to it.

Show Colour Palettes
Shows only colour palettes in the palette list. This is the default 

option.

Show Pencil Texture 

Palettes
Shows only pencil texture palettes in the palette list.

Show All Palettes Shows both colour and pencil texture palettes in the palette list.

Palette List

Icon Description

In Harmony Server, this indicates that you have the rights to modify the palette.

Indicates that the palette is stored at the same level as its palette list. For example, a palette that is 

stored in the scene's palette library and which is listed in the scene's palette list, or a palette that is 

stored in an element's palette library and which is listed in that same element's palette list. 

Indicates that the palette file is stored in an external location, such as a different scene, an element in 

a different scene, a job other than the scene's job, or an environment other than the scene's 

environment. This means the palette is liable to be missing if it is moved from its original location, or if 

the scene is exported from the database into an offline scene or to a different database.

This indicates that the palette is stored at a higher level than its palette list, making it a shared 

palette. For example, a palette in your scene's palette list that is stored in the palette library of the 

scene's job or environment, or a palette in an element's palette list that is stored in the palette library 

of the scene.

Indicates a potentially dangerous situation. For example, a palette file that is stored in one of the 

scene's element folders, but which is added to your scene's palette list. The whole scene can use the 

palette, but since it's stored inside an element, deleting that element w ill make your whole scene lose 

access to that palette. 
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Navigation Panel

Icon Option Description

Previous Drawing Navigates to the previous drawing in the loaded drawings list.

Next Drawing Navigates to the next drawing in the loaded drawings list.

Previous Column Switches to the previous column in the loaded columns.

Next Column Switches to the next column in the loaded columns. 

Line Art View and edit the drawing's line art layer.

Colour Art View and edit the drawing's colour art layer.

Preview Line Art and Colour Art

If enabled, both the drawing's line art and colour art layers w ill 

be visible. If disabled, only the art layer you are currently 

working on w ill be visible. 

Colour Swatch List Panel

Icon Option Description

Add Colour Adds a new colour swatch to the bottom of your colour list.

Remove Colour 

The Remove Colour  button lets you delete the currently selected 

colour swatches. If the colour swatch is used in your project, and 

confirmation dialog w ill appear prompting you to confirm that you 

want to delete the colour. Zones painted w ith colour swatches 

which have been deleted w ill turn red, easily identifying them so 

you can repaint them with another colour swatch.
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Add Texture 

Allows you to import a bitmap image as a texture, which can be 

painted w ith just like a colour. W hen used w ith the Brush or Paint 

tools, bitmap textures are tiled inside the shape they fil l. The 

scaling and position of the texture inside their shape can be 

tweaked w ith the Edit Gradient/Texture tool. W hen used w ith the 

Pencil tool or one of the Shape tools, a bitmap texture w ill follow 

the pencil l ine's direction. 

Set Current Brush Colour 
W hen enabled, the colour you select in the colour view will be 

selected for the Brush tool. 

Set Current Pencil Colour 

W hen enabled, the colour you select in the colour view will be 

selected for the Pencil tool, as well as other tools that create 

pencil l ines, such as the Line, Rectangle, Ellipse and Polyline tools. 

Set Current Paint Colour 
W hen enabled, the colour you select in the colour view will be 

selected for the Paint tool.

Link/Unlink Three Colours W hen enabled, the colour you select w ill be selected for all 
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drawing tools. W hen disabled, you can select individual colours 

for the Brush, Pencil and Paint tools. 

Edit Palette Mode 

In Harmony Server, this allows you to get the modifying rights to 

the selected palettes. 

Since several people can work on any given scene at the same 

time, and a palette can be shared between scenes, palettes may 

be loaded in read-only mode when opening a scene on a Harmony 

database. Then, an user would only be able to edit a palette by 

first activating Edit Palette Mode. This prevents several users from 

making changes on the palette at the same time, since a user 

cannot activate Edit Palette Mode on a palette that is already 

being edited by someone else. This also prevents users from 

accidentally making modifications on important palettes.

Edit Palette Mode Indicator

In Harmony Server, this icon appears when you have the modifying 

rights on the currently selected palette.

NOTE 

In Harmony Stand Alone, you can always modify your 

palettes. 

  Colour Swatch Name 

Each colour swatch available in the Colour view can have its own 

name, making it easy to identify which colour is used to paint what 

part of your character or background. 

NOTE 

Two colours can have the same name. Harmony identifies 

colours by an identification number. 

  Colour Swatch Also referred to as colour pots, the colour swatch is the actual 
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colour information for a colour in your palette. It is represented by 

a rectangle displaying the colour in the list. 
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Drawing View

Only the selected drawing is displayed by default in the Drawing view. You can use features, such as the light 

table to display the current drawing of all the enabled layers of your scene in washed-out colours, or the 

Onion Skin to display the previous and next drawings of the currently selected drawing layer.

How to access the Drawing view

Do one of the follow ing:

 l From the top menu, select W indows > Drawing .

 l From any of the other views, click the Add View  button and select Drawing.

Icon Section Description

View Menu

The View menu contains all the tools and options that 

you can use in the Drawing view to draw, animate and 

paint.
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  Drawing Area
This is the main space in the Drawing view. It is where 

you draw and where the drawings are displayed.

  Zoom Menu

The Zoom menu lets you enlarge or reduce the 

Camera or Drawing view display. 

To make the camera frame size always match the size 

of your view, select the Fit to View option. Click the 

drop-down arrow and select a zoom level or press 1 

and 2.

  Drawing Name

The Drawing Name field displays the name of the 

selected drawing, as well as the layer containing it. If 

the cell does not contain any drawing, an Empty 

Cell text is shown in the field.

  Tool Name

The Tool Name field displays the name of the selected 

tool. If you temporarily override a drawing tool using a 

keyboard shortcut, the tool’s name will be highlighted 

in red. You can temporarily override a tool by holding 

its keyboard shortcut w ithout the Alt key. For 

example, the Select tool shortcut is Alt + S. If you hold 

down the S key, you w ill sw itch to the Select tool. 

W hen you release the key, you w ill return to the tool 

you were using.

  Frame Number
This field displays the current frame of the animation 

you are working on.

  Cursor Coordinates
This indicates the position of the your pointer in the 

drawing area.
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  Colour Picker
The Colour Picker allows you to select a colour for 

drawing.

 
Drawing Thumbnails 

Panel

The Drawing Thumbnails panel displays a list w ith 

thumbnails of the loaded drawings. The highlighted 

drawing is the one displayed in the drawing area. You 

can select the drawing you want to paint directly from 

this list.
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Integrated Help View

Use the Integrated Help when you are unsure about what a certain menu item is or the function of a specific 

preference in the Preferences panel.

If you keep the Integrated Help w indow open for the entire duration of your work session, then you can use the 

forward and backward arrows to scroll through  a history of the help information that you called up during your 

session.

How to access the Integrated Help view

 1. Do one of the follow ing:

 l From the top menu, select W indows > Integrated Help.

 l From any of the other views, click the Add View  button and select Integrated Help.
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Message Log View

The Message log view displays information gathered during a render task, such as which frames and at what 

time they were each rendered. The view also contains a list of the colour recovery operations.

How to access the Message Log view

Do one of the follow ing:

 l From the top menu, select W indows > Message Log.

 l From any of the other views, click the Add View  button and select Message Log.

250



Reference View

W hen you are drawing, you can use a fully-painted drawing or bitmap image as a reference and load it in the 

Reference view. This drawing or bitmap image can be used and loaded in any of your Harmony scenes.

Once imported, your references w ill be saved in the scene, and you w ill not need to re-import them. To load 

your previously used references in the scene, right-click the Reference View Toolbar and select Load Default 

References.

How to access the Reference view

Do one of the follow ing:

 l From the top menu, select W indows > Reference View.

 l From any of the other views, click the Add View  button and select Reference View.

Tool/Menu Item Icon Description

View Menu
The View menu contains all the tools and options that 

you can use to manage references.

  Reference View Toolbar

The Reference View toolbar contains all the tools and 

options you can use in the Reference view to navigate 

through and manage references.
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Colour Eyedropper
Allows you to select a colour by clicking on a colour in 

your artwork. 
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Tool Properties View

T-HFND-004-002

The Tool Properties view contains the most common options and operations related to the currently selected 

tool. W hen you select a tool from the Tools toolbar, the Tool Properties view updates.

For example, if you choose the Select  tool, the Tool Properties view will display the options and operations 

related to it, such as Snap to Contour, Apply to All Drawings, Flip Horizontal, and Flatten.

NOTE 

To learn more about the options appearing in the Tool Properties view, see Tools Properties on 

page 56.

How to access the Tool Properties view

Do one of the follow ing:

 l From the top menu, select W indows > Tool Properties.

 l From any of the other views, click the Add View  button and select Tool Properties.
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